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 The Digital Fortress: 
Don’t Get Soft on Hardware
It doesn’t matter what your creative superpower happens to be, if 
you don’t have the right hardware and gear, you’re crime-fighting 
career could be cut short. Daniel East gives us some great advice 
on what to consider when creating our individual digital fortresses. 
From computers and displays to what you should do with your old 
superhero gear, Dan covers it all here.

Daniel M. East
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 DOWNLOADABLE CONTENT 
Whenever you see this symbol at the end of an article, it means 
there are either downloadable practice files or additional content 
for KelbyOne members at http://kelbyone.com/magazine.

 New Features  
in Lightroom CC
Adobe recently announced Lightroom CC with major new features 
for improving a photographer’s workflow and productivity. RC 
Concepcion shows us how to use People view to identify faces 
in our catalogs, and how to create panoramas and HDR images 
directly inside of Lightroom—no Photoshop required. 

RC Concepcion
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	 MAXIMUM WORKFLOW	 102 	 Macphun Snapheal Pro

	 LIGHTROOM TIPS & TRICKS 	 107

� KEY CONCEPTS 
These icons at the beginning of columns indicate there’s a short video on a tool 
or function used in that tutorial at the Key Concepts KelbyOne member webpage 

at http://kelbyone.com/keyconcepts.
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Quick Selection toolPen tool

Layer masksLasso tool

LIGHTROOM
FEATURE

	  Reviews
108	 Ricoh’s PENTAX 645Z

109	 Jot Touch with Pixelpoint 
	 DSLR ProPack

110	 Chimera RingMAXX 
	 Elinchrom ELB 400

111	 ipt NexGen Actions 
	 Pogo Connect 2

112	 Photoshop Book Reviews

But Wait— There’s More

Fr
an

ce
sc

a 
H

ug
he

s
La

ur
i N

ov
ak

C
hr

is
 S

uc
h

All lighting diagrams courtesy of Sylights

Click this symbol in the magazine to return to the Table of Contents.
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There’s so much awesome stuff going on right now, I’m not going to be able to fit it all on this one page, but I’m sure gonna try. 
Lightroom CC is here! The big news is that we have a new version of Lightroom (the first major update since 2013), and of course, 

we’re making sure you have the best, most up-to-date training on it. We started by releasing 14 new KelbyOne full-length online 
Lightroom CC classes by RC Concepcion, Pete Collins, and me on launch day, and you can watch them right now. We have every-
thing from our “In-depth” series where we really dig into all the features (old and new) to my new class called Learn Lightroom CC  
in One Hour where I’m speaking to photographers who are brand new to Lightroom and want to get up and running fast. These  
14 new classes are just the first wave, as we have a second wave coming right behind them with more in-depth courses and more of 
what you’ve told us you want to learn next in Lightroom. 

Here in the magazine, we wanted to cover Lightroom CC in a big way, so not only do we have a feature story on the major new 
CC features by RC (p. 87), but we also have a deeper dive by Rob Sylvan (p. 92). We’ve been expanding our Lightroom coverage  
in the magazine lately, and beginning this issue you’ll see we have a “magazine inside a magazine” just for Lightroom starting on 
page 85, which means lots of Lightroom love in this and future issues. 

Photoshop World is around the corner: This year’s big Photoshop World Conference & Expo (produced by KelbyOne and spon-
sored by Adobe) is coming a bit earlier: August 11–13, 2015, in Las Vegas. We’re hoping the earlier date will allow more educators 
to attend than our previous September dates, which cut out a lot of educators who wanted to be there. We’re working hard to 
make this the best conference ever with more classes, some awesome new instructors, and new opportunities for fun and learning! 

Sign up now and save $100 with our early-bird special. You’re going to learn more in three days than you have in three years, and 
you’ll have a ball doing it. Visit PhotoshopWorld.com for more information.

We’re cranking out the classes: Every Thursday is “New Class Thursday” and we’ve been rolling out lots of new classes on the 
Adobe Creative Suite apps; video shooting, editing, and production; and some awesome new Photoshop classes. We also have some 
brilliant talks with some of the most inspirational and business-minded people in our industry, so make sure you’re checking out these 
new classes each week. (We do them just for you!) 

And new shows: RC and I have been producing a great new weekly Lightroom show called (wait for it, wait for it) The Lightroom 
Show. It’s short (about 12 minutes), sweet (well?), and right to the point, but you won’t believe how much we cover in such a short 

“lunch-break” show. You can find it on the KelbyOne member site. I also invite you to join RC, Pete, and me daily over at our Light-
room blog, LightroomKillerTips.com. Also, don’t miss the new KelbyOne Blog (KelbyOne.com/blog) where we post new content 
all the time (you’ll super-dig it!). 

We’re jammin’ here in the mag, too: I wouldn’t miss pro-retoucher Kristina Sherk’s tips and tricks for retouching eyes (on p. 46), 
or Daniel East’s cover story with hardware advice for everything you need know to work better, faster, and more securely, from 
computer systems and displays to cloud storage and card readers (p. 60). 

For photographers, we’ve asked some of the best in the business to give us advice on camera gear for folks who are just starting 
out (p. 74). We have Moose Peterson on landscape and wildlife photography, Frank Salas on wedding and events, Rick Sammon on 
travel and environmental portraiture, and Matt Hernandez on sports. And we’re just getting started (but sadly, I’m already out of room). 

Until next issue, here’s hoping you’re having a blast with all these amazing new tools, and I hope we’re helping you along on 
your learning journey. 

All my best, 

Scott Kelby
KelbyOne President & CEO
Editor & Publisher, Photoshop User

From the Editor
 �a new version of lightroom  
and lots of new training

A  F E W  W O R D S  F R O M  ›  ›  S C O T T  K E L B Y
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http://lightroomkillertips.com
http://kelbyone.com/blog/
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He is one of the Photoshop Guys and co-hosts Photoshop User TV. With a fine arts 
background, Pete is well versed in photography, graphic design, and illustration. 
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. As a KelbyOne member, you automatically 
receive Photoshop User delivered right to your door (or 
digitally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $19.99 per month or $199 U.S. for a full 

year of training. To learn more, visit www.kelbyone.com.

 

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes,  

and quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne.  
It’s produced exclusively for members to keep you informed of everything 
new in the industry and at KelbyOne headquarters.

FIND KELBYONE MEMBERSHIP DETAILS AT kelbyone.com or call 800-201-7323 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits

https://kelbyone.com/
https://kelbyone.com/
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›  › Inspiration, information, and member musings to fuel your creative think tank
BY HEATHER SHORTT

KelbyOne Community

New to the 
kelbyone social scene: periscope
Exploding onto the social spectrum the past couple of months is a Twitter-owned app called Periscope. This live-streaming 
video platform lets users share real-time video—or as the creators call it, “the closest thing to teleportation.” When we first 
heard about the opportunity to live-stream video so easily, quickly, and effortlessly, we said, “Um, duh, we’re in!” After all, 
you know how we’re always miraculously camera ready (some of us anyway). 

So how will this work for us (or should we say you, our dedicated fans)? Now that we have this really cool instant-learning tool, 
we can send live quick tips anytime we want, and that’s exactly what we’ve been doing. Each week our content team throws out 
tips and tricks and even some behind-the-scenes antics via Periscope for your viewing and learning pleasure. 

To join in on the fun, all you have to do is download the Periscope app to your iPhone or iPad (sorry, Android users, but we hope 
Periscope has you connected soon), and log in using your Twitter handle. Be sure to follow KelbyOne and Scott Kelby. Plus, you’ll 
find tons of other KelbyOne instructors. Check out Scott’s blog post where he shows you how to get Periscope and who to follow 

at scottkelby.com/2015/twitters-periscope-app-is-simply-awesome. We’ll be seeing you soon—in real time. 

Snapseed 2.0 
is here!  
If you haven’t heard the news, Snapseed by Google received a major upgrade in April. Snapseed introduced photographers 
of all kinds to version 2, which is packed with new features that take this photo-editing tool for phones and tablets to a 
completely new level. 

Our very own RC Concepcion is a huge fan of this app and was super stoked to dive right into its capabilities—not just for 
his personal use, but also to show users just how powerful this app has become. Of course, we did this all in our signature 
teaching style, making it simple, fast, and fun to learn how to make really great photos with Snapseed. 

In this full, 28-lesson class called Making Great Pictures with Snapseed 2.0, RC takes users step by step through Snap-
seed 2, showcasing its intuitive controls that make it easy to get the most out of images you take with your phone or DSLR 
camera. You’ll learn not only how to use these controls efficiently and effectively, but also discover the hidden features that 
really push your images up a notch.

So if you haven’t quite uncovered all that this hot new release has to offer, or you want to make sure you’re using the 

tool to its fullest capabilities, be sure to watch RC’s class at kelbyone.com/blog/snapseed. 

Fresh New Classes 
	 released at kelbyone.com

Here’s a roundup of our latest classes and tutorials that 
you won’t want to miss. Log into your member account at  
KelbyOne.com or check out these new releases on our app. 
Not a member? You can try KelbyOne for free. Visit KelbyOne 
.com/freetrial to view these classes and more. 

Next Level 3D 
Join Photoshop master Corey Barker and learn how to take 
your 3D skills to the next level in one of our latest online 
training courses. Corey will take you step-by-step through 
three different projects, and you’ll discover the benefits of 
using 3D effects in your work. This class has something for 
illustrators, designers, and photographers, and it will leave 
you wanting to dig into 3D to see what you can do in your 
next project. 

Moose Peterson’s Safari Adventure
With a career studying and photographing wildlife for more 
than three decades, Moose Peterson recently took his first  
African safari, and you have a front-row seat. Join Moose as he 
encounters the wide array of wildlife that calls the Mala Mala 
Game Reserve in South Africa home. Moose shares his take on 
the gear he brought along for the safari, along with tips and 
techniques for capturing images that help tell the story.

The Art of Digital Photography: The Inspirational Series with 
Matthew Jordan Smith 
Check out the latest class in our “Inspirational Series.” This time 
we’re featuring beauty, fashion, and celebrity photographer, 
Matthew Jordan Smith. Learn how he got his start in photog-
raphy and the many lessons he learned along the way that 
helped catapult his career in the last three decades. 

http://scottkelby.com/2015/twitters-periscope-app-is-simply-awesome/
http://kelbyone.com/blog/snapseed
http://kelbyone.com/
http://kelbyone.com/
http://KelbyOne.com/freetrial
http://KelbyOne.com/freetrial
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ARTIST SPOTLIGHT  ›  ›  KENT AUF DER HEIDE 
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If you could photograph any event what would it be? 

I’d love to be the first person to take a portrait of an extra-

terrestrial, but with my luck they’d look just like us, and 

no one would believe it wasn’t anything more than just 

another portrait. 

Who plays Don Clark in a movie about your life? 

Any actor that attended the Tri-Lamb fraternity in Revenge  

of the Nerds. I own and embrace my inner and outer nerd. 

What would we be surprised to know about you? 

I was a magician for a brief time. My magic skills have long 

since atrophied. But today with Photoshop, I think of myself 

as a visual magician. 

If you could go back and give your younger self any 

advice, what would it be? 

My life and career have played out the way it was meant 

to play out, and it hasn’t been a bad ride. I can’t imagine 

how things would be now if I changed anything in the past. 

I probably wouldn’t say, “You’re on the right road, follow 

your heart, and you’ll get there.” 

Well, “All Being of time, space, and matter,” the world is 

yours, and we can’t wait to see what you have up your sleeve 

next. Check out Don’s work on the KelbyOne member site at 

http://members.photoshopuser.com/drclrk/portfolio or at 

www.donclarkphoto.com. ■

Who’s Who in the  
	 kelbyone community

Meet Don Clark, a three-year KelbyOne member who battles 

it out in our weekly Pixel Fight Club, and our latest creative 

mind to catch the eye of Pete Collins. Check out what keeps 

this self-proclaimed nerd working hard to keep his portfolio 

polished and his creativity fresh. 

So you’re a commercial/advertising photographer. Tell 

us about these cool Converse Kicks you shot. 

Trying to force an idea isn’t the best way to get a result you’re 

looking for. Sometimes, you just have to let go and let things 

happen. When I created the Converse shot, it was toward 

the end of a very long day and things weren’t going the way  

I wanted. Out of total unprofessional frustration, I grunted, 

picked up the shoes, and just threw them down on the set. 

However they landed was how they were going to be shot. 

I had to search for that needle in the haystack and eventually 

found it. The result is the shot you see. I’ll be “letting go” 

more often; it seemed to work in my favor this time.

How has KelbyOne helped grow your creative skills? 

Lately, I’ve been interested in the creation of the composited 

image. Being part of the Pixel Fight Club has truly been an 

exercise in total creativity for me. Professionally, I serve the 

art director; in Pixel Fight club I am the art director. I thank 

KelbyOne and Pete Collins for providing a creative play-

ground for all members and me. 

We like helpful tips. What’s the best tip you’ve received? 

The portfolio is your visual voice: Say what you want, make 

it meaningful, and take it seriously! It’s the first professional 

impression any potential client will have of you.

Can we have glimpse at what’s on your bucket list? 

I’m a firm believer in setting obtainable goals; obtain one, 

and then move on to the next. I’ll give you three things from 

my bucket list: Named All Being of time, space, and matter; 

make any kind of sense of the 3D feature in Photoshop; and 

go to Europe again.

The stage is yours—share your proud achievements. 

Recently, my work has been accepted into the internation-

ally curated online art gallery 1X.com and was chosen to be 

included in the fine-art book, Passion. This is a huge honor for 

me, considering the caliber of talent on that site. 

How do you stay inspired? 

Some days it truly is a struggle. I’m not an island; a lot of 

my professional work is a team effort. Fortunately for me,  

I have a very creative team on my side. Their efforts make me 

look good. 

http://kelbyone.com/
http://members.photoshopuser.com/drclrk/portfolio
http://www.donclarkphoto.com
https://1x.com
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BY CHRIS MAIN

Canon Introduces New 4K Digital Cameras 
and drops lens prices
Canon has announced the XC10 4K Digital Camcorder, which will be available this  

June. The XC10 can capture 4K and Full HD video, as well as 12-megapixel still  

images. It also has a built-in function to extract 8-megapixel stills from recorded  

4K video. Its 10x wide-angle zoom lens offers a 35mm equivalent  

of 24.1–241mm for stills and 27.3–273mm for movies, and its  

1" CMOS sensor delivers up to 12 stops of dynamic range.  

According to Canon, the XC10 is ideal for creative individuals  

and professionals looking for cost-effective 4K video production.  

The XC10 will have an estimated price of $2,499 with a SanDisk  

64-GB CFast 2 card and card reader. 

Canon also announced the new EOS C300 Mark II Digital  

Cinema Camera, which will be available in September. At an  

estimated price of $20,000, this camera is for the serious cinema,  

documentary, event, or commercial videographer. The Mark II features  

evolutionary updates, including a new 8.85-megapixel Super 35mm Cinema CMOS Sensor, new Dual DIGIC DV5 processors,  

a new Canon XF-AVC Codec that allows 10-bit 4:2:2 4K image data to be recorded internally, and an expanded dynamic range  

of up to 15 stops. 

And finally, Canon also announced that they’ve dropped the price on 33 of their EF lenses. That’s great news, because who 

doesn’t like to spend less money? The price drops range from $30–$800. For more information on these new cameras and 

lens prices, visit www.usa.canon.com.

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

Adobe’s Creative Cloud Photography Plan Gets Boost 
with a new version of lightroom
Adobe recently announced the availability of Lightroom CC. If you’re hip to Adobe 

lingo, you know CC stands for Creative Cloud, which means if you’re a subscriber, 

then you already have access to all the great new features in the latest version of 

Lightroom. If you’re not a subscriber, don’t worry; Adobe released this same ver-

sion as Lightroom 6 for $149.

Adobe’s Creative Cloud Photography plan is only $9.99 a month and 

includes both Lightroom CC and Photoshop CC, plus mobile capabilities that 

include accessing and editing your entire catalog on iPad, iPhone, and Android 

smartphones and tablets. Not a bad price to pay for all of that power.

Instead of wasting ink here on all the new features in Lightroom CC, 

check out RC Concepcion’s article on page 87 for a look at all the major 

new features, and then flip to page 92 for an article by Rob Sylvan where he 

talks about all the little tweaks and changes that will make your photographic 

life better. And don’t forget to check out our Lightroom CC Learning Center at  

http://kelbyone.com/lightroomcc/lightroomcc-resource-center.

https://www.usa.canon.com/internet/portal/us/home
http://kelbyone.com/lightroomcc-bkup/
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Platypod Pro Provides Support for Your Camera 
that fits in your pocket
What can you do when you need stable support for your camera but you don’t 

have your tripod with you? How about the Platypod Pro? Simply attach your 

favorite ball head to this small, sturdy, flat base, place it on the ground, a chair, 

or a table, and you’re ready to take rock-steady pictures.

The Platypod Pro is made out of rigid, aircraft-grade aluminum that mea-

sures 3x5", and because it’s only 0.16" thick, it can easily fit into your pocket 

or any compartment in your camera bag. The 3/8" titanium screw is welded to 

the base and will accommodate most professional ball heads. A second 1/4" 

titanium screw at the other end of the plate can be used for video mics, trans-

mitters, a flash accessory hot shoe, and so on. The Deluxe Kit comes with a high-quality case, three spikes for balancing the plate 

on uneven surfaces, and a 1/4"–3/4" female spigot adaptor. The case can also carry a small ball head (not included, of course). 

The Deluxe Kit sells for $49.95. For more information, visit www.platypodpro.com.

OWC Premieres Viper Pro Thunderbolt 
at nab 2015
At NAB in Las Vegas, OWC (Other World Computing) premiered the Viper Pro Thunderbolt external SSD. According to OWC, 

the Viper Pro is the pinnacle of fast, high-capacity, direct attached Thunderbolt storage, and is engineered to meet the extreme 

demands of content professionals. Its dual Thunderbolt 2 ports deliver speeds up to 1350MB/s and can support multi-stream, 

uncompressed 4K video and bus-powered daisy chains. It’s available in either 4- or 8-TB capacities at $2,999 and $4,799, 

respectively, and should be available this summer. For more information, visit www.macsales.com.

Go Noiseless  
with macphun
Macphun, maker of award-winning photography software for the Mac, has 

released Noiseless and Noiseless Pro. Macphun designed Noiseless to clean up 

digital noise fast with one click. It automatically detects the amount of noise  

in an image and chooses the best preset for you. The Pro version works as a 

plug-in for both Lightroom and Photoshop, has advanced RAW noise-reduc-

tion technology with four additional presets for RAW, supports PSDs, and 

more. The standard version is $17.99 and the Pro version is $49.99. For more 

information, visit www.macphun.com. ■

http://www.platypodpro.com
https://www.macsales.com
https://macphun.com
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The new reboot of Mad Max opens this month, so I thought it would 
be great to create a poster inspired by the movie. You’ll see how 
some simple layer tricks can allow you to create entirely new envi-
ronments, and you’ll also get an idea of how you can use 3D models 
in your 2D designs. 

Rebooting Mad Max
B Y  C O R E Y  B A R K E R



› › D O W N  A N D  D I R T Y  T R I C K S

› 
› 

k
e

l
b

y
o

n
e

.c
o

m

023

Step One: We’ll start with a stock image for the background. We 
chose this nice shot of Monument Valley because it has a great 
foreground area to place our subjects and a nice sense of depth 
with the bigger elements in the distance. The sky, however, won’t 
work for this design because we need something a bit more dra-
matic, so we need to extract the ground area from the sky.

[KelbyOne members may download the files used in this tuto-
rial at http://kelbyone.com/magazine/issue/may_june_2015.  
All files are for personal use only.]

Step Two: From the Toolbox, choose the Quick Selection tool (W). 
Click-and-drag around the sky area until all of the sky is selected. 
If any areas of the ground area get selected, just hold down 
the Option (PC: Alt) key and click-and-drag over those areas to 
deselect them. Go to Select>Inverse to switch the selection from 
the sky to the ground.

Step Three: Once you’ve made your basic selection, click on the 
Refine Edge button in the Options Bar. When the dialog opens, 
click on the View preview thumbnail in the View Mode section 
and change it to On Layers so you can see the ground on a trans-
parent background. Use the Refine Radius tool (E) to paint along 
the horizon of the scene so it adds a little transparency along the 
edges, which will ease the transition from this scene to the new 
sky we’ll be adding. When done, go to the Output section, set 
the Output To drop-down menu to New Layer, and click OK.

Step Four: Create a new blank document (File>New) measur-
ing 540x800 pixels at 72 ppi. This will be the document in which 
we’ll build the design. Switch to the Move tool (V), drag the 
extracted ground element into this new file, and position it as 
you see here. 

Step Five: Next, we have an image containing the sky we want 
to use. The clouds in this photo are much more dramatic and 
interesting than in the original shot. With the Rectangular Mar-
quee tool (M), draw a selection around just the sky area. Using 
the Move tool, drag-and-drop this selected area to the design file. 

Step Six: Drag the sky layer below the ground layer in the Layers 
panel. Then, press Command-T (PC: Ctrl-T) for Free Transform, 
and scale the sky to fit in the image. It will need to be scaled verti-
cally, so don’t add the Shift key to maintain proportions. You can 
get away with stretching this image at a certain level because the 
sky itself is abstract. Press Enter to commit the transformation.

Step Seven: While the clouds look good, the color, or lack of 
it, doesn’t work here. So, click the Create a New Layer icon at 
the bottom of the Layers panel, and make sure this new layer 
is directly above the sky layer. In the Toolbox, select the Gradi-
ent tool (G). In the Options Bar, click on the gradient thumbnail 
preview; choose the Foreground to Background preset, which is 
the very first one in the Gradient Editor; and click OK. Select the 
Radial Gradient icon in the Toolbox.

Step Two

Step Three

Step Four

Step Five Step Six
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Step Eight: Click on the Background color swatch at the bottom 
of the Toolbox to open the Color Picker. Locate the RGB fields 
and set them to R:47, G:110, and B:93. This will give you a dark 
green. Click OK. Next, click on the Foreground color swatch, and 
this time set the numbers to R:237, G:208, and B:139 for a pale-
yellowish color. Click OK.

Step Nine: With that blank layer active, click to start the gradient 
exactly on the horizon between the two monuments on the right, 
and then drag up to just beyond the top-left corner. Near the top 
left of the Layers panel, set the layer blend mode to Overlay.

Step Ten: We can see some anti-alias fringing along the 
edge of the ground where it meets the sky. You can fix that 
quickly by making the ground layer active, and then going to 
Layer>Matting>Defringe. Set the Width to 2 pixels and click OK. 
This clears up the edge fringe nicely.

Step Eleven: The sky looks great but it has a little too much 
contrast in the middle area where the text for the title will even-
tually be placed. Here’s a nifty trick to fix that. Make a duplicate 
of the cloud layer by making it active and pressing Command-J 
(PC: Ctrl-J). Then, change the layer blend mode to Multiply and 
drop the layer Opacity to 50%. Press Command-I (PC: Ctrl-I) to 
Invert the layer.

Step Twelve: We only need this effect in the center area of the 
sky, so click the Add Layer Mask icon (circle in a square) at the 
bottom of the Layers panel to add a mask to this layer. With 
the Gradient tool active, click on the gradient thumbnail in the 
Options Bar, choose the Foreground to Transparent preset, and 
click OK. Select the Linear Gradient icon in the Options Bar, and 
then drag gradients from the edges of the document toward 
the center to fade out the outer edges of this Multiply sky layer.

Step Thirteen: With the new sky, the ground seems a bit oversat-
urated. Make the ground layer active and press Command-U (PC: 
Ctrl-U) to open the Hue/Saturation dialog. Drop the Saturation 
setting to –10. This will tone down the colors of this layer a little. 

Step Fourteen: Now we need to add the subjects of our poster, 
which will be a lone character and a vehicle in the foreground 
area. Let’s start with the vehicle. Here’s where you can really see 
the potential of 3D in 2D compositing. I found a free 3D model of 

this ATV at Archive3D.net. (There are loads of 3D models that you 
can download for free, and most are compatible with Photoshop. 
You just have to try and see what works—but hey, it’s free!) 
Anyway, the real beauty here is that you can modify the position, 
scale, angle, and even the lighting of the 3D model to match your 
scene—something that you just can’t do with a 2D image. 

Step Fifteen: Here, you can see the rendered vehicle once  
I had all the 3D settings in place. Sadly, I don’t have enough 
pages for this tutorial to explain the entire 3D process here, but 
you can see every step of this procedure in an exclusive video at 

www.kelbyone.com/blog. Step Fifteen

Step Nine

Step Twelve

Step Thirteen Step Fourteen
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Step Sixteen: After the vehicle was lit and rendered, it was 
rasterized into a regular layer. (If you’re a KelbyOne member, 
you’ll find the rasterized version of the vehicle in the down-
load files. Open that file and drag the ATV into your design 
file. Use Free Transform to scale the image to fit in the scene.) 
Though the lighting and shadows look good, the base color of 
the vehicle is still a dark gray and it looks a little too clean for 
the desert. We’ll fix that with a simple texture. Here’s a rust 
texture that will work nicely, which we’ve also provided as part 
of the exercise downloads.

Step Seventeen: Once you’ve opened the texture, bring it into 
the design layout and make sure it’s just above the vehicle layer. 
Use Free Transform to scale and position the texture over the 
entire vehicle and its shadow as shown here. Next, hold down 
the Option (PC: Alt) key and click in between the two layers to 
create a clipping group, making the texture visible only in the 
vehicle in the layer below. Drop the rust layer Opacity to 60%, 
and change the layer blend mode to Overlay. This grunges up the 
vehicle nicely for the scene.

Step Eighteen: Now it’s time for our lone hero. I found this 
stock image of a mysterious guy standing alone. It’s a great shot, 
but we only need the guy. Grab the Quick Selection tool again 
and paint a selection of just the guy. To remove the small area 
between his body and arm from the selection, grab the Magic 
Wand tool (nested under the Quick Selection tool in the Tool-
box), and Option-click (PC: Alt-click) that hole.

Step Nineteen: When you’ve 
made your selection, click on the 
Refine Edge button in the Options 
Bar. All we need to do here is 
bump up the Radius slider to 0.7 
px in the Edge Detection section, 
and then boost the Contrast set-
ting to 25% to tighten up the 
selection. Lastly, set the Output To 
drop-down menu to New Layer, 
and click OK.

Step Twenty: Drag the extracted character into the main docu-
ment, and then position and scale him to the right, just in front 
of the vehicle as you see here. Make a duplicate of this layer by 
pressing Command-J (PC: Ctrl-J).

Step Twenty-One: With the duplicate layer active, press Com-
mand-U (PC: Ctrl-U) to open the Hue/Saturation dialog. Check 
on Colorize and set the Hue to 31, the Saturation to 29, and 
the Lightness to 5. Click OK. This will put a warm cast over the 
subject to help him blend into the new scene. Step Twenty-One

Step Seventeen

Step Eighteen

Step Twenty

Step Sixteen
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Final

Step Twenty-Two: For the man’s shadow, we’re going to use 
the original layer of him below. Make that layer active and lock 
its transparency by clicking on the Lock Transparent Pixels icon 
(checkerboard) next to the word “Lock” near the top left of the 
Layers panel. Use the Eyedropper tool (I) to sample the shadow 
color of the vehicle, then press Option-Delete (PC: Alt-Backspace) 
to fill the man’s shape with that color. You won’t be able to see it 
in the document because of the duplicated layer on top. 

Step Twenty-Three: Go to Edit>Transform>Flip Vertical. Then, 
using the Move tool, drag the shadow down to where the feet are 
touching. Go into the Transform menu again but this time choose 
Distort. Use the bottom-center control point to manipulate the 
angle of the shadow, using the vehicle shadow as a guide. (I took 
a little bit of license with the shadow here because I wanted to see 
the whole shadow. If I followed the angle of the vehicle shadow, 
it would have cast his shadow right on the vehicle.) 

Step Twenty-Four: Drop the layer Opacity for the shadow down 
to 75%, and then add a layer mask. Switch to the Gradient tool 
and, using the same linear Foreground to Transparent settings, 
drag a gradient from just beyond the head of the shadow toward 
the man’s feet. This will fade the shadow like you see here. 

Step Twenty-Five: Finally, we’ll add a little atmospheric per-
spective. With the Gradient tool still selected and set to the Fore-
ground to Transparent gradient, choose the Reflected Gradient 
icon in the Options Bar. Set the Foreground color to a light yel-
low. Create a new blank layer above the ground layer and draw 
a gradient just above the horizon. Change the layer blend mode 
to Screen, and drop the layer Opacity to around 75%. 

Drop in some text, and there you have it! You can see how I added 
the text, as well as how I added the 3D model in that special sup-

plemental video that I mentioned earlier at www.kelbyone.com/

blog. ■ 

Step Twenty-Two

Step Twenty-Three

Step Twenty-Four

Step Twenty-Five

http://kelbyone.com/blog/
http://kelbyone.com/blog/


http://www.topazlabs.com/mktg/psuser-lake.html
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Recently, a friend was having a 30s gangster-style mystery party 
for her birthday, and she asked me if I’d design the invitation. The 
invitation came out so well that I carried that theme into a full-blown 
classic film-noir style poster. In this tutorial, I’ll show you how to create 
your own stylized poster.

film noir gangster poster
B Y  C O R E Y  B A R K E R
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Step One: We’ll start this design with one of the main sub-
jects of the image. Here we have a cool classic gangster on a 
dark background. We need to extract him from the image but 
there’s little-to-no contrast between him and the background. 
This makes it hard for the Quick Selection tool (W) to detect the 
edges; however, we have a trick that can help the Quick Selec-
tion tool a little.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/may_june_2015. All 
files are for personal use only.]

Step Two: Click on the Create New Adjustment Layer icon (half-
white, half-black circle) at the bottom of the Layers panel and 
choose Levels. (This adjustment needs to be nondestructive, so 
make sure you apply it as an adjustment layer.) In the Proper-
ties panel, drag the midtone slider to the left until you can see 
all the way around the edge of the subject. Don’t worry about 
how much it blows out the image; just make sure you can see 
all the edges. 

Step Three: Grab the 
Quick Selection tool 
in the Toolbox, and 
start painting to cre-
ate the selection. Even 
if the adjustment layer 
is still active, it will still 
detect the layer below. 
You can either paint 
on the subject or you 
can do what I like to 
do: Paint to select the 
background first, and 
then inverse the selec-
tion to the subject 
(Select>Inverse). If the 
Quick Selection tool 
selects something that you don’t want selected, hold the Option 
(PC: Alt) key and paint that area to subtract it from your selec-
tion. The goal is to get the selection as close as possible, but it 
doesn’t have to be perfect (we’ll work on that in the next steps). 
Once you have a pretty clean selection around the subject, you 
can throw away the adjustment layer by dragging it to the Delete 
Layer icon (trash can) at the bottom of the Layers panel.

Step Four: Click on the Refine Edge button in the Options Bar. 
When the dialog opens, click on the View mode thumbnail and 
set it to Black & White. You’ll see an alpha-channel version of 
the selection. You’ll also notice the edge is rather soft, and even 
somewhat pixelated. Grab the Refine Radius tool (E) and paint 
around the edge of the subject to clean up the edge. It will include 
some random spots around the edge and won’t look so perfect, 
but here we’re just concerned with getting the clean edge.

Step Four

Step One

Step Two
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Step Five: Still in the Refine Edge dialog, bump up the Radius in 
the Edge Detection section to around 2.5 px, and then go down 
to Contrast and increase the setting to around 17%. Finally, set 
the Output To drop-down menu to New Layer with Layer Mask 
and click OK. 

Step Six: You’ll see some spots around the edges that show 
the background. We need to clean those up, and we’ll do 
that directly on the layer mask. Select the Brush tool (B) in the 
Toolbox and choose a small, round brush with a Hardness of 
about 30%. Set the tool blend Mode in the Options Bar to 
Overlay. Click on the layer mask thumbnail in the Layers panel 
to make it active, and then press D to set the Foreground color 
to white.

Step Seven: Paint around the edge of the subject from the inside 
out. This will clean up the edge of the mask by forcing the gray 
pixels to white. You don’t have to worry about the edge because 
in Overlay blend mode, it will ignore the black areas. If you 
need to mask away pixels on the outside of the subject, press X  
to make the Foreground color black and paint from the outside 
in. Tip: Use the Bracket keys on your keyboard to quickly change 
the size of the brush.

Some areas may not be affected with the Brush in this mode, 
so you’ll have to switch the blend mode back to Normal in the 
Options Bar, and then paint in those areas. Just be careful if 
you’re close to the edge. When done, you should have a cleanly 
extracted subject from a dark background.

Step Eight: Now we’re going to add an interesting fade on 
the subject. Go to the Channels panel (Window>Channels) and 
make a duplicate of the Blue channel by dragging it to the Create 
New Channel icon at the bottom of the panel. 

Step Nine: Select the Gradient tool (G) in the Toolbox; click on 
the gradient preview thumbnail in the Options Bar; choose the 
second preset (the Foreground to Transparent gradient); and 
click OK to close the Gradient Editor. Then, choose the Radial 
Gradient icon in the Options Bar, and press D to set the Fore-
ground color to white. Finally, set the Gradient tool blend Mode 
to Overlay in the Options Bar. Click in the lower-left area of the 
channel and drag the gradient toward the upper right as shown 
here. Repeat this about seven or eight times to create a high-
contrast fade as a result of the blend mode.

Step Ten: Press Command-L (PC: Ctrl-L) to open the Levels dia-
log. Use the black Eyedropper tool and click on the lightest area 
of his right hand to force the rest of the subject to black. Click 
OK. If some areas get missed, then just use the Brush tool and 
paint with black in those areas. 

Step Eleven: Back in the Layers panel, make the layer mask 
active again. Go to Select>Load Selection. Choose the Blue copy 
from the Channel drop-down menu, and click OK. Press D to 
make the Background color black, and then press Command-
Delete (PC: Ctrl-Backspace) to fill the selection with black. This Step Ten

Step Five

Step Eight

Step Nine

Step Seven
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will mask out the new fade on the image. Press Command-D 
(PC: Ctrl-D) to deselect.

Step Twelve: Now let’s 
build the base of the 
design. Start by creating 
a new blank document 
(File>New) that’s 600x900 
pixels, and then for this 
exercise, open the tex-
ture file. I like this texture 
because of the grain but 
not the color, so press 
Shift-Command-U (PC: Shift-Ctrl-U) to remove the color informa-
tion. Open Levels again (Command-L [PC: Ctrl-L]), set the white 
Output Levels to 200 to darken the overall texture, and click OK.

Step Thirteen: Use the Move tool (V) to drag this texture into 
the main design file that you just created. Press Command-T (PC: 
Ctrl-T) for Free Transform and, if needed, scale the texture to 
fit in the overall image area. Press Enter to commit the trans-
formation. Once this background texture is in place, bring the 
extracted subject over to the main layout and position him on the 
left side as you see here.

Step Fourteen: Click the Create 
a New Layer icon at the bottom 
of the Layers panel. Drag this 
new layer so it’s above the tex-
ture layer and below the subject 
layer in the layer stack. Using the 
Rectangular Marquee tool (M), 
draw a rectangular selection simi-
lar to what you see here. Press D  
to set the Foreground color to 
black, press Option-Delete (PC: 
Alt-Backspace) to fill the selection 
with black, and deselect. 

Step Fifteen: Double-click on the layer thumbnail for the black 
rectangular layer to open the Blending Options, which is part of 
the Layer Style dialog. Down in the Blend If section, Option-click 
(PC: Alt-click) the white slider below Underlying Layer to split it, 
and drag the left half of the slider toward the center. This will 
allow the texture to show through the black rectangle. Click OK. 

Step Sixteen: Click the Add Layer Mask icon (circle in a square) 
at the bottom of the Layers panel to add a mask to this layer. 
Press X until the Foreground color is black. With the Gradient 
tool still set to a radial gradient and the Foreground to Transpar-
ent preset, draw gradients to add a fade in the lower-left area of 
the rectangle to remove it from the stylized fade of the subject 
and to lighten the bottom edge a little. 

Step Twelve

Step Fifteen

Step Sixteen

Step Thirteen Step Fourteen
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D O W N  A N D  D I R T Y  T R I C K S  › ›

Step Seventeen: Make the texture layer active, click on the Add 
a Layer Style icon (ƒx) at the bottom of the Layers panel, and 
choose Gradient Overlay. Use the settings I have here to add a 
little bit of a dramatic-light effect on the background. 

Step Eighteen: Now we have another subject to add to the 
scene. The image of this woman fits the mood just right and the 
file is part of the exercise download. Use the Quick Selection tool 
to select her (it’s not necessary to use a Levels adjustment layer 
in this case). Go into Refine Edge and use the Refine Radius tool 
around the subject’s hair. Then, just boost the Contrast setting to 
around 35% to clean up the rest. Set the Output To drop-down 
menu to New Layer and click OK.

Step Nineteen: Use the Move tool to bring her into the main 
layout and drag her to the top of the layer stack in the Layers 
panel. Use Free Transform to resize and position her in the com-
position as you see here, and then add a layer mask to this layer. 
Switch to the Gradient tool and select the Linear Gradient icon 
in the Options Bar. Draw a gradient starting below the woman 
to add a simple linear fade at her bottom edge. We also added 
a little radial gradient to the mask of the black rectangle layer 
behind her head to give the illusion of light, setting her apart 
from the background more.

Step Twenty: To enhance the lighting on both subjects, first 
create a new blank layer above the man. Using the Gradient tool, 
press X until the Foreground color is white, and draw a simple 
radial gradient over his head. Change the layer blend mode at 
the top left of the Layers panel to Soft Light. Also, drop the layer 
Opacity to around 70%.

Step Twenty-One: Now do the same for the woman, only this 
time click on the Foreground color swatch and select a light-red 
color in the Color Picker. Set this layer to Soft Light blend mode, 
and drop the layer Opacity to around 35%.

Step Twenty-Two: Make the layer containing the black rect-
angle active, and select the Smudge tool (nested under the Blur 
tool in the Toolbox). In the Options Bar, choose a simple spatter 
brush from the Brush Preset Picker, set the Strength to around 
75%, and make sure Sample all Layers is turned off. Then, give 
the lower-right corner of the rectangle a little stylized smudge 
like you see here. 

Step Twenty-Three: Finally just add some text, a little smoke 
coming from the cigarette, and voilà! ■ 
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Step Nineteen

Step Twenty-One

Step Twenty-Two

Step Twenty-Three
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Down

Dirty
Tricks

If you find your House is Stark or you stare at the Wall in the Night 
Watch(ing), then you may want to prepare your own shield because 
“winter is coming!” Okay, if you don’t have a clue about any of these 
references, and you can’t imagine when you’d need to make a shield, 
don’t worry; this technique can be adapted to make wonderful old-world 
signs just as easily.

game of drones
B Y  P E T E  C O L L I N S
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Step One: This technique only uses three images. Choose a 

wood texture image that has good character, and find a metal 

background that has a beat-up, old-world feel. Finally, choose 

your emblem (sigil) for the center of the shield. This emblem was 

created by merging a couple of elements in Illustrator, but you 

can use just about anything you like. Flat graphic elements tend 

to work best. Open the wood texture image.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/may_june_2015. All 

files are for personal use only.]

Step Two: Click the Create a New Layer icon at the bottom of 

the Layers panel, and hide the Background layer by clicking its 

Eye icon. Use the Pen tool (P) to make a simple half-shield shape 

like the one shown here. Make sure the Pen tool is set to Path in 

the Options Bar. Right-click on the path, choose Make Selection, 

and click OK to convert the path to marching ants.

Step Three: Click on the Background layer to make it active, 

and then make it visible again by clicking where its Eye icon used 

to be. With a selection tool active, such as the Rectangular Mar-

quee tool (M), position the selection over the wood and press 

Command-J (PC: Ctrl-J) to make a half-shield wood cutout on a 

new layer. Command-click (PC: Ctrl-click) the thumbnail of the 

half-shield layer to bring back the selection.

Step Four: Click-and-drag the marching ants to another sec-

tion of wood, click on the Background layer in the Layers panel 

to make it active, and copy the selection to a new layer again. 

Hide the Background layer once again. Press Command-T (PC: 

Ctrl-T) for Free Transform, then Right-click and choose Flip Hori-

zontal. Line up the two pieces to make a complete shield, and 

press Enter to commit the transformation. You should still have 

a blank layer where you created the path in Step Two. Drag that 

layer below the two shield layers in the Layers panel, press D to 

set the Foreground and Background colors to their defaults, and 

then press Command-Delete (PC: Ctrl-Backspace) to fill the layer 

with white.

Step Five: This step isn’t necessary, but it can give the shield a 

bit more depth. In the Layers panel, double-click on one of the 

shield layers (the right one in this example) to open the Layer 

Style dialog (see next page). Click on Gradient Overlay in the list 

of Styles on the left side of the dialog. Click on the Gradient 

thumbnail preview, select the Foreground to Background preset 

in the Gradient Editor, and click OK. Check on Reverse so the 

gradient goes from white to black. Change the Blend Mode to 

Overlay, lower the Opacity to 64%, and set the Angle to 0°. This 

will darken the right side of the shield and lighten the left side 

of the right half, making it look as if it’s coming forward just a 

touch. Click OK to apply the layer style.

Step One

Step Four

Step Two Step Three
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Step Seven Step Eight

Step Six

Make sure this layer (the one with the layer style) is above the 

other shield layer in the Layers panel, and press Command-E (PC: 

Ctrl-E) to merge the two layers together. This trick will maintain 

the gradient overlay layer style in the merge.

Step Six: Open the metal texture image, switch to the Move 

tool (V), and while holding the Shift key, click-and-drag the metal 

texture into the shield document. The Shift key will center the 

texture in the document. Drag the metal layer below the shield 

layer in the Layers panel. Click on the shield thumbnail while 

holding the Command (PC: Ctrl) key to load the shield shape 

as a selection. Hide the shield layer, make sure the metal layer is 

active, and then press Command-J (PC: Ctrl-J) to make a copy of 

the shield shape in the metal. Hide the original metal layer.

Step Seven: You’ll need to make the metal expand beyond the 

edges of the wooden shield, so turn the shield layer back on, 

press Command-T (PC: Ctrl-T), and while holding both the Shift 

and Option (PC: Alt) keys, drag out one of the corner transform 

handles. This will expand the metal shape outward from the 

middle while maintaining its shape. Eyeball how thick you think 

the trim should be, but give yourself enough room to add the 

rivets that we’ll make in the next step. Press Enter to commit the 

transformation.

Step Eight: Create a new layer and switch to the Brush tool (B). 

Right-click in your document to bring up the Brush Preset Picker, 

select a round brush, and set the Hardness to 100%. Adjust the 

Size so that the brush fits inside the metal trim area of the shield. 

Set the Opacity of the brush to 100% in the Options Bar, and 

press D to set the Foreground color to black. Click to add black 

dots all around the shield where you want the rivets to be placed.

Step Nine: Once all the dots are set, Command-click (PC: Ctrl-

click) on the dots layer thumbnail image in the Layers panel to 

create a selection around each dot. Hide the dots layer, make the 

metal trim layer active, and press Command-J (PC: Ctrl-J). This 

will make a new layer with metal dots copied onto it. Hide the 

metal trim layer for now.

Step Five
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Step Twelve

Step Thirteen

Step Eleven

Step Ten: Use the Zoom tool (Z) to zoom in on one of the flat 

rivets you just made so you can see the changes you’ll be mak-

ing. Double-click on the rivets layer to bring up the Layer Style 

dialog. Start by adding a Bevel & Emboss. The key to getting the 

right look here is to change the Technique setting to Chisel Hard. 

Experiment with the other settings. The settings shown here are 

for a high-res file; if you’re using the low-res practice file, you’ll 

need to use lower settings.

Step Eleven: Next, click on the Texture option below Bevel & 

Emboss in the list of Styles on the left side of the Layer Style 

dialog. We want to add a little texture to the rivets so it looks like 

they have some wear and tear. Click on the Pattern thumbnail 

to open the Pattern Picker, and select the texture called Noise, 

which is the seventh one in the default set of textures. You may 

need to adjust the Scale to get the right amount of “texturisity” 

(my word). Feel free to add a little Drop Shadow to the rivets, as 

well. Click OK to apply the layer styles. In the example shown 

here, the top rivet shows the layer styles applied.

Step Twelve: Make the metal trim layer visible again, and zoom 

out to look at the whole shield. You may see that the wood sec-

tion could use a drop shadow, and the rivets are too bright and 

look a little fake. Start by double-clicking on the wood shield 

layer in the Layers panel to open the Layer Style dialog, and add 

a Drop Shadow. Remember, when adding a drop shadow, sub-

tlety is usually better, so when you have a shadow that you think 

looks good, back it off by about 10%.

Now, double-click the words “Bevel & Emboss” that appear 

under the rivets layer in the Layers panel to go back to that sec-

tion of the Layer Style dialog. Lower the Highlight Mode Opacity: 

Changing it from the default to around 32% will dull the rivets 

to make them look less fake. Click OK.

Step Thirteen: This is where your inner artist can come out and 

play. Make the wood shield layer active and click the Add Layer 

Mask icon (circle in a square) at the bottom of the Layers panel. 

Repeat for the metal trim layer and the rivet layer. Now choose 
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Step Fourteen Step Fifteen

Step Sixteen

the Brush tool (B), set the Foreground color to black, and start 

roughing up the edges of the shield and the rivets using different 

brushes. Make sure to click on the layer mask thumbnail for each 

layer before you start painting so you’re painting on the mask. 

The 63 Watercolor Loaded Wet Flat Tip brush just past the leaf 

brushes in the Brush Preset Picker is a fun one to use.

Go around all the edges but, as with drop shadows, be subtle. 

If you do too much, press X to switch the Foreground color to 

white and paint back some of the dings. Use the Bracket keys 

on your keyboard to quickly change the size of the brush. The 

great thing about the rivets is that, because they’re using layer 

styles, each dab of paint on the mask looks like it’s carving into 

the texture.

Step Fourteen: Open the emblem image that you have either 

made or downloaded, and use the Move tool to drag it on top 

of the shield. Set its blend mode to Multiply near the top left 

of the Layers panel. Use Free Transform to resize and position 

the emblem.

Step Fifteen: To make the emblem look like it’s been through 

a battle, you’ll want to roughen it up. Lower the layer Opacity to 

58%, and then double-click on the layer to bring up the Layer 

Style dialog. At the bottom, use the Blend If sliders to let some 

of the wood show through. The key is to hold down the Option 

(PC: Alt) key while grabbing the white and black sliders to split 

them apart to have more precise control.

Step Sixteen: Make a copy of the emblem layer and add a 

layer mask to each layer. With a grungy brush set to black at 

about 20% Opacity, go back and forth between the two layer 

masks and brush away sections of the emblem. The two layers 

allow you to be subtle and use the character of the wood to help 

decide which parts of the emblem should be more visible, which 

parts completely hidden, and which parts semi-transparent.

Now your shield is ready for battle. Simply drop it into a scene, 

add the appropriate parody title (so as not to get sued), and 

you’re good to go. Or, as mentioned in the beginning, change 

the shape from a shield to a rectangle and make a sign. ■ 

D O W N  A N D  D I R T Y  T R I C K S  › ›
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LESA SNIDER
Beginners' Workshop
 how to make a typographic logo

INCORPORATE CONTRAST
Contrast is key in creating a visually pleasing typographic logo. To 

add contrast, try pairing big text with small; thick fonts with thin; 

fancy fonts with plain; tight character spacing with expanded; 

and so on. The more contrast, the better.

STACKED TEXT BLOCK
Stacking lines of text into a block is another way to create a visu-

ally pleasing logo, as shown on the right. If you go the squished 

route (middle), you’ll need to vary text color to keep it readable.

SEND THE RIGHT MESSAGE
Your font choice, as well as size and spacing, conveys a message. 

For example, an open, rounded font, such as Futura or Helvet-

ica Neue set in all lowercase, exudes a friendly, affordable feel, 

whereas a script font (say, Adios Pro) exudes glamour. A thin serif 

font (Copperplate) set in all caps conveys a feeling of exclusivity 

and extra dollar signs, while a slightly rotated rough font (Caslon 

Antique) exudes a casual, rugged feel.

FORMATTING TEXT IN PHOTOSHOP
Step One: Now let’s create one of these logos in Photoshop. 

Choose File>New and create a document that’s 5x3" at 300 ppi 

(resolution), which gives you plenty of canvas space to play with. 

Click OK.

Step Two: When designing a logo, try working in black 

and white; after all, if it works with no color, it’ll just look 

better in color. Press D to set the color chips at the bot-

tom of the Toolbox to their default values of black and 

white (circled), and then press the X key on your key-

board until black is on top. Now press T to grab the Type 

tool (also circled).

Step One

Send the Right Message

Incorporate Contrast Stacked Text Block

Logos are notoriously difficult (and costly) to design, yet they’re mission critical for any business. Instead of using 
graphics, try a typographic approach instead. Typographic logos are both timeless and classy. In this column, you’ll 
learn essential design tips and how to master text formatting so you can make one yourself.
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Step Three: Click within your document and Photoshop 

creates a new type layer. Enter your first and last name 

in lowercase with no space between them. Double-click 

your text to highlight it, which temporarily puts a black 

background behind it and makes the letters look white. 

Tip: In Photoshop CC, you don’t have to highlight text to 

change fonts (just make sure your cursor isn’t inserted 

anywhere in the text). However, if you want to change 

a portion of a type layer to a different font, you must 

highlight that part.

Step Four: In the Options Bar, use the field at far left to 

specify font family, which refers to the character design. 

The field to its right lets you pick a font style, which refers 

to all the design variations contained within a font family, 

such as regular, light, italic, bold, semibold, black, and 

so on. (That said, you can specify font style in the first 

field, too.)

Click the first field and pick Helvetica Light or Myriad 

Pro Light, if you have them. (In Photoshop CC, this field 

is searchable; just start typing the name of the font you 

want and Photoshop hunts it down.) Set the third field to 

20 points so you can see what you’re doing.

Next, use your cursor to highlight your last name (just 

like you would in a word processor), and from the font 

style field, choose Bold. Click the type layer’s thumbnail 

in the Layers panel to un-highlight the text so you can see 

the final result. You can’t go wrong if you use different 

styles within the same font family; however, contrast is 

key—when pairing thin with thick, the thick text must be 

three times thicker than the thin.

Tip: You can increase the font size of highlighted text 

in 1-point increments by pressing Shift-Command-> 

(PC: Shift-Ctrl->), and decrease it by pressing Shift-

Command-< (PC: Shift-Ctrl-<). To increase or decrease in 

5-point increments, add the Option (PC: Alt) key. 

Step Five: It’s often easier to create each line of text 

on separate type layers so you can rotate a line, posi-

tion text precisely, and so on. For this example, let’s add 

another line of text to the same type layer. With the Type 

tool active, click to the right of the last letter in the first 

line and press Return (PC: Enter) to add another line. 

Enter “photography” in all lowercase, and double-click 

it to highlight it. In the Options Bar, choose a Light ver-

sion of the font family you used before (say, Myriad Pro 

Light). Reduce text size to half the size of the previous 

line (10 points). 

Step Four

Step Five
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Step Six: Choose Window>Character to open the Character 

panel. Use kerning to adjust space between pairs of letters where 

it looks off, such as between the “e” and “s” in “lesa.” Position 

your cursor between the offending letters, point your cursor at 

the kerning control in the Character panel and, when your cursor 

turns into a hand with two arrows (a scrubby cursor), drag left to 

decrease space or right to increase it. Keyboard shortcut: Press-

and-hold Option (PC: Alt) while tapping the Left or Right Arrow 

key to change kerning in increments of 20. Add the Command 

(PC: Ctrl) key to change in increments of 100. 

Step Seven: Use tracking to increase spacing between all let-

ters uniformly in the second line so they’re equal in width to the 

first line. That way, the relatively tight spacing of the first line 

contrasts with the airy spacing of the second line. Double-click 

to highlight the word “photography” and point your cursor at 

the tracking control in the Character panel. When the scrubby 

cursor appears, drag right to increase it until it’s the same width 

as your name. Keyboard shortcut: Highlight some text and then 

press-and-hold Option (PC: Alt) while tapping the Left or Right 

Arrow key. Add the Command (PC: Ctrl) key to change tracking 

in increments of 100. 

Step Eight: Use leading to adjust the amount of space between 

lines of text in the same type layer. To adjust the leading of a sin-

gle line of text on a type layer that contains many lines, highlight 

the line of text first, point your cursor to the leading control, and 

when the scrubby cursor appears, drag left to decrease it to 9 

points. Keyboard shortcut: Hold Option (PC: Alt) and tap the Up 

or Down Arrow key to change leading in increments of 1 point. 

Add Command (PC: Ctrl) to change it in increments of 5 points. 

To set leading back to Auto, press Shift-Option-Command-A 

(PC: Shift-Alt-Ctrl-A). 

Once you create a logo you like—whether it looks like one of 

these examples or not—try experimenting with text color. When 

you’re finished, save a master copy for future editing by choos-

ing File>Save and picking Photoshop as the file format. To save 

a copy suitable for print, use the Crop tool (C) to crop the doc-

ument to the logo and then choose File>Save As. Pick TIFF or 

PDF for file format and click Save. To save a copy for online use, 

choose File>Save for Web and pick PNG for file format (PNG cre-

ates crisper text than JPEG format). 

As you can see, creating a typographic logo isn’t rocket science; 

it just takes a little skill and patience. Until next time, may the 

creative force be with you all! ■

Step Six

Step Seven

Step Eight
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K E Y  C O N C E P T S  › › Layer masks

KRISTINA SHERK
Dynamic Range
 awesome eyes

Eyes can say so much without speaking a word. That’s why 

retouching them is very important. As photographers, your 

image’s message is relayed to your viewer through your model’s 

eyes. Oftentimes in retouching tutorials and classes, the topic of 

eyes is just glossed over. Not here, not today.

This article is devoted entirely to retouching eyes. From intensi-

fying their color to creating dimension, sharpness, and shape—it’s 

all covered. So let’s dive in.  

EYE WHITES
We’ll start with the eye whites. First, let’s identify our problem 

areas: The whites have some veins in them, and some redness. 

The eyes also look a bit flat in general. Let’s fix the veins first.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/may_june_2015.  

All files are for personal use only.]

Step One: If you’re starting with a new, flat document (like the 

practice file that’s available for KelbyOne members), you’ll need 

to press Command-J (PC: Ctrl-J) to duplicate the Background 

layer. Double-click the name of the new layer in the Layers panel, 

and rename it “Inverted High Pass.” (I’ve already done some 

general cleanup work on the practice file.)

If you’re working on a document that has multiple layers, 

you’ll need to stamp the visible layers into a new layer. Click 

on the top layer in the Layers panel, and press Shift-Option- 

Command-E (PC: Shift-Ctrl-Alt-E). That’s my favorite keyboard 

shortcut because it’s like playing twister with your fingers.

Step Two: Now we’ll use the Filter>Other>High Pass command 

to isolate the texture. Play around with the Radius in the High 

Pass dialog until the eye veins are accentuated. For this image, 

the Radius was 6 pixels but it will vary depending on your image. 

Click OK.

Step Three: Next, we’ll desaturate the Inverted High Pass layer. 

Press Command-U (PC: Ctrl-U), then drag the Saturation all the 

way down to –100 in the Hue/Saturation dialog, and click OK. 

Change the layer’s blend mode to Soft Light near the top left of 

the Layers panel. 

The face is the mirror of the mind, and eyes without speaking confess the secrets of the heart.—St. Jerome

Step Three

Step Two

Step One
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Step Four: Click on the Inverted High Pass layer in the Layers 

panel to make it active, and press Command-I (PC: Ctrl-I) to 

invert it. You should see the image switch from sharper to blur-

rier, blurring the veins in the eyes. They’ll now be less noticeable. 

Step Five: We don’t want this effect to be applied to our entire 

image, so hold down the Option (PC: Alt) key and click on the 

Add Layer Mask icon (circle in a square) at the bottom of the Lay-

ers panel. This will add a mask filled with black, hiding the effect. 

We’ll then paint with a white Brush (B) on the black mask to 

reveal the blurring effect on her eye whites. It’s all right if the eye 

whites look slightly muddy; we’ll take care of this later. Here’s 

what my Layers panel looks like and a close-up of my mask. 

Step Six: Now we’ll take care of the redness. Create a Selective 

Color adjustment layer by clicking on its icon in the Adjustments 

panel (Window>Adjustments). It’s the second to last icon. Let’s 

name this layer “Red Removal.”

Step Seven: Select Whites from the Colors drop-down menu 

in the Properties panel. We need to decrease how much red is 

present in the white tones, so drag the Magenta slider down to 

–64%, and drag the Yellow slider down to –16%. But, remem-

ber to trust your eye. The objective is to remove red and some 

yellow from the eye whites, so your values may differ.

Choose Neutrals from the Color drop-down menu. Drag the 

Black slider to –42%. This will correct the tone in the whites so 

they’re back to a natural, brighter value. 

Step Eight: It looks great except that this adjustment is affect-

ing the whole image. Let’s fix this by making our Red Removal 

layer active in the Layers panel and then choosing Create Clip-

ping Mask from the Layers panel’s flyout menu at the top right of 

the panel. Immediately, your adjustment will only show through 

where the mask on the Inverted High Pass layer mask is white. 

Step Seven

Step Five

Step Six
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Step Nine: Our last step with the eye whites is to make sure they 

still retain their three-dimensional round shape. An eyeball is just 

that: a ball. It’s round, and some newbie retouchers forget that. 

They’ll brighten the corners of the eye whites thus making the 

eyeball appear flat. So let’s add shadows back into the corners of 

the eyes to make them look round. 

Create a new layer using Shift-Command-N (PC: Shift-Ctrl-N). 

In the New Layer dialog, name the layer “Eye Dodge and Burn,” 

change the Mode to Soft Light, and place a checkmark in the 

box next to Fill with Soft-Light-neutral Color (50% gray). Now, 

we can click OK. 

Step Ten: Using the Brush tool (B), we’ll paint with black on the 

Eye Dodge and Burn layer, but make sure the Opacity and Flow 

of your brush are low in the Options Bar. I used 20% for both.

A quick keyboard shortcut: Once you’ve activated the Brush 

tool, use the number keys to choose the opacity you want to 

paint at (1=10%, 5=50%, 9=90%, etc.). If you hold the Shift key 

while you press the number keys, you’ll be able to choose your 

Flow in the same way.

We’ll finish by painting in the corners of the eyes to give the 

eyes that rounded look. This is a great way to keep the eyes look-

ing smooth, sleek, and most importantly, natural. Here’s the Eye 

Dodge and Burn layer with the layer blend mode changed back 

to Normal just for illustration.

Step Nine

Step Ten

Before

After
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Step Two

Step One

LIQUIFYING EYES
Liquifying eyes can be done to slightly increase the size of the 

model’s irises and constrict pupil size, mostly in fashion or beauty 

photography, but please be cognizant of what message your 

client or model wants to portray in their portrait. I’ve had some 

actors come in for headshots who have asked to make their pupils 

larger because of the subconscious message it sends to the viewer.

If you’re going to use this kind of effect in your photographs, 

make sure you do the research. Also, remember to retain the 

integrity of the circle shape of the iris. Sometimes, when people 

open eyes using the Liquify tool, they tend to stretch the sides of 

the iris, making them look more box-like in shape.

Step One: To start, make sure you’re on the topmost layer 

in the Layers panel, and then stamp visible: Shift-Option- 

Command-E (PC: Shift-Alt-

Ctrl-E). Rename this layer 

“Liquify.” Turn this layer into 

a smart object so you can edit 

it nondestructively and come 

back to it later if you need 

to by Right-clicking on the 

layer and choosing Convert 

to Smart Object. Then select 

Liquify from the Filter menu. 

Step Two: Here’s the before 

and after of the iris Liquify, as 

well as a screen grab of the 

brush settings I used for the 

Forward Warp tool (W). Notice 

how I also reshaped the reflec-

tions in her eyes.

IRIS COLOR
Let’s move on to one of the most important parts of eye 

retouching. I want to add color to the eye but my model (as 

many do) has two different colors in her iris, so we can’t add 

one color to the eye and call it a day. Here’s a new technique 

I’ve been using for amazing eyes.

Step One: Start by creating a new blank layer and naming it  

“Color 1.” Then, use your Brush tool to paint a color over the 

model’s irises. Select a color that’s similar to the model’s original 

iris color. You can use the Eyedropper tool (I) to sample your color 

if you like, or you can click on the Foreground color swatch at the 

bottom of your Toolbox and select the color in the Color Picker. 

Be sure to change the Opacity and Flow in the Options Bar back 

to 100%.

Before

After
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Step Two: Change the layer’s blend mode to Soft Light. Double-

click to the right of the layer name for Color 1 to bring up the 

Layer Style dialog. Go to the Blend If section at the bottom, 

and play around with the white and black sliders for Underlying 

Layer until you get your color to show up in the lighter areas 

of the iris. Your values will be different on every image, so I’m 

teaching you the technique more than the actual settings. Here 

are what my sliders look like. Hold the Option (PC: Alt) key and 

click a slider to split it. Drag the halves around until you get the 

desired effect. Splitting the sliders will give you smoother transi-

tions. Click OK when you’re done.

Step Three: Now comes the fun part. Duplicate the Color 1 

layer by pressing Command-J (PC: Ctrl-J) and name it “Color 2.” 

Double-click the two overlapping boxes on the right side of the 

Color 2 layer in the Layers panel to open the Layer Style dialog 

again. We want to change the areas where this layer is visible.

We want the color in this layer to show through where the 

color on the other layer (Color 1) is hidden. To do this, we 

need to change the Blend If sliders. You don’t want the same 

eye color value to be affected by both your Color 1 and Color 

2 layers, so you can see in the two screen grabs of my Layer 

Style dialogs (this step and the previous step) that the darkest 

value that Color 1 affects is 122, and the brightest color that 

Color 2 affects is also 122. So Color 1 applies one color to 

the highlights of the iris, while Color 2 applies another color 

to the darker colors in the eyes. Here are my slider values for 

this layer. 

Step Four: Now let’s create a Hue/Saturation adjustment layer 

(it’s the first icon in the second row of icons in the Adjustments 

panel), and check the Colorize box at the bottom of the Hue/

Saturation Properties panel. Name this layer “Color Change.” 

Go to the Layer panel’s flyout menu and choose Create Clipping 

Mask. If your Color Change layer is directly above your Color 2 

layer, the color adjustment of the Color Change layer will only be 

visible where there are actual pixels on the layer below it: Color 2.

Click on the thumbnail icon of the Color Change adjustment 

layer and play with the Hue and the Saturation settings in the 

Properties panel. You’ll only see the change appear in the darker 

values of the iris. Change the colors until you find something that 

complements the first color. If at any time you feel that this effect 

is too heavy, click on either Color layer and decrease its visibility 

using the Opacity slider in the Layers panel. 

Step Five: The last step for adding dimension is creating a 

Curves adjustment layer (third icon in the first row in the Adjust-

ments panel). Let’s name this layer “Local Contrast.” Next, click 

on the little hand with the left-pointing finger in the Properties 

panel. This is called the Targeted Adjustment tool (TAT).

Step  Three

Step Five

Step  Two
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Step Six: Zoom pretty far into one of the irises. Click on 

a lighter color in the iris and drag up slightly. Then, click a 

darker color in the iris and drag down. This will create dimen-

sion and contrast in the iris (but it also intensifies the colors 

in the iris, which we don’t like). To fix this, change the blend 

mode of that layer to Luminosity, then invert the mask to 

hide the effect. Paint with white to expose the contrast only 

on the iris areas. You can paint as much or as little as you 

want. Here’s the before and after showing the iris color work 

that we did. 

EYE SHARPENING
People can often over-sharpen eyes to the point where they 

start to get ghosting around them (especially around the eye-

lashes). The way I try to protect my sharpening from this is to 

gradually build it up layer by layer. 

Step One: To start, let’s stamp visible again: Shift-Option-

Command-E (PC: Shift-Alt-Ctrl-E). Use the Filter>Other>High 

Pass command to sharpen the image. Use a low radius (we 

used 3 pixels).

Step Two: Completely desaturate the High Pass layer: Com-

mand-U (PC: Ctrl-U) and lower the Saturation to –100. Change 

the layer’s blend mode from Normal to Soft Light. We named 

our layer “Sharpen.” Hold down Option (PC: Alt) and click the 

Add Layer Mask icon to hide the effect. Paint using white on 

the mask to expose the things that you want the most sharp-

ening applied to. For me, this was the iris. I stayed away from 

the eyelashes.

Step Three: Duplicate the Sharpen layer. Now, we can add 

more white to the mask and expose more of the sharpening. 

Include more areas, such as the eyebrows, upper lashes, and 

lower lashes. Make sure you’re painting on the mask, though, 

after you duplicate the layer. This keeps the focus where it should 

be, and means you won’t over-sharpen the lashes.

Here’s the finished before and after images of everything we’ve 

applied to our model’s eyes. They look great and will now mes-

merize any viewer! ■ 

Step Six

Before

Original

After

Final
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now set the layer blend mode to Subtract in the Layers panel. 

The colors will invert, and the black square is now white. Spiffy!

Destructive Ways
Of course, the idea can be extended to using multiple colors, 

different blend modes, and other tools. But there’s a catch: 

Once you’ve used a blended tool with the pixels on that layer, 

the result is baked in. You can paint new strokes with differ-

ent blend modes and colors, but you can’t change the results 

of the mode that’s already been applied. That black (or white) 

square you see is now a permanent part of the layer. Like-

wise, while you can lower the Opacity or Flow before you 

make an overlapping stroke, once it’s there, you can only 

build it up—you can’t go back and change it without using 

the Undo command.

Let’s dig in and see how to use these tool-based blends, starting 

with a refresher on how they differ from layer-based blend modes.

Layer-based blend modes rely on comparing pixels between 

layers, while tool-based blend modes compare pixels on a single 

layer. (Note: Layer styles have their own rules, which I’ll cover 

in a future article.) Put another way, layer blend modes require 

you to have more than one layer, and the layer with a blend 

mode applied needs something below it to blend with. Tools that 

manipulate or paint pixels, such as the Brush tool (B), need pixels 

on the current layer to blend with. Other than that, the math is 

the same when two blend modes are the same.

In both cases, there needs to be something to compare, so 

the only real difference is where that comparison is made. Try 

this exercise: Create a new document with a plain white layer 

and a blank layer above that. Choose a soft, round Brush set to 

100% Opacity and 100% Flow in the Options Bar. On the blank 

layer, paint a single stroke with any bright, solid color.

Now set the Mode drop-down menu in the Options Bar to 

Subtract, and paint an overlapping stroke. Where the strokes 

meet, they are blended with the Subtract mode, and will end 

up black. Where there were no pixels already on the layer, the 

color you selected is painted like normal. Whenever you paint 

over pixels that are already on the layer, you’ll blend those pixels 

with whatever is coming out of your tool. To convince yourself, 

SCOTT VALENTINE
Photoshop Proving Ground
 tool-based blend modes

H O W  T O  › ›

Most Photoshop users learn about blend modes fairly early on, usually as they’re applied to layers. Lots of tools 
also make use of blend modes: You may have seen this when learning about the Brush tool and layer styles. 
When the Brush tool (B) is active, the Options Bar at the top of the interface gives you a drop-down list of mostly 
the same blend modes that you’d find in the Layers panel.
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This is inherently destructive, and we’ve generally been 

taught to avoid such things. Working on duplicate layers 

and being aware of undo steps will help alleviate any prob-

lems, though.

Fun and Practical Applications
Now we can look at some ways to put this information to use. 

One way to explore blend modes is the following exercise: 

Select the Gradient tool (G), click on the gradient preview in 

the Options Bar to open the Gradient Editor, and choose a gra-

dient preset that has lots of colors, such as those in the Color 

Harmonies collections (click on the gear icon at the top right 

of the Gradient Editor, select Color Harmonies 1 or 2, and click 

Append in the resulting dialog to add that set of presets to the 

Gradient Editor).

Choose a blend mode (I like Soft Light or Difference for this 

exercise) and randomly drag out gradients on the same layer. 

Try different blend modes, different gradient presets, and dif-

ferent gradient types, such as Radial or Angle in the Options 

Bar. If you create something you like, save it and start on a new, 

blank layer. You would be amazed at the variety of graphic 

patterns you can create this way. These examples used a solid 

stripe gradient set to Radial, with various colors and blends cho-

sen for different passes.

› › P H O T O S H O P  P R O V I N G  G R O U N D
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If you paint in Photoshop, a killer way to add depth without 

having to adjust your palette is to switch your brush to Multiply 

or Screen blending. Then, lower the Flow and Opacity values to 

around 10% and continue painting on your layer. Painting with 

the same color and Multiply will darken the tones, while painting 

with Screen will lighten them.

Photographers can also use this same trick to remove slight 

casts in highlights, or even out small variations in skin tone 

(bottom right). In this case, use Color with your brush, and 

sample a good skin tone from your subject, then slowly paint 

over problem areas. (Tip: With the Brush tool active, press-and-

hold Option [PC: Alt] to temporarily switch to the Eyedropper 

tool and click to sample a color.) While you can do this on a 

blank layer set to Color, if you’re confident with the changes 

you want to make and work slowly, you can commit those 

edits right on your main layer. This saves you a little file size 

and it’s just a bit quicker.

Many Tools Use Blend Modes
There are many tools that accept blend mode changes (I have 

a complete list of tools and their blending options in my book, 

The Hidden Power of Blend Modes, 2012, Adobe Press). I don’t 

have space here to give every option in detail, but here are the 

tools that use blend modes in some way: Healing Brushes; Clone 

and Pattern Stamps; Brush and Pencil; History and Art History 

Brushes; Color Replacement; Gradient and Paint Bucket; and 

Blur, Sharpen, and Smudge.

Not all of the tools have all the modes, and some tools have 

unique blend modes. Even trickier is that some of the blend 

modes are hidden in other options. Specifically, the Brush tool 

hides a few in the Brush panel (Window>Brush) options for Tex-

ture and Dual Brush. And because Photoshop can’t leave well 

enough alone, there are two unique blend modes there: Height 

and Linear Height. I honestly haven’t tried those—if you discover 

how to use them, please write me!

Interestingly, Mixer Brushes do not currently enable blend modes.

Each of the tools follows the general rule of comparing pix-

els from the tool with pixels already on the layer, but there are 

some quirks. The Smudge tool, for example, also has an option 

to include composite data (Sample All Layers); it can pick up pix-

els from layers below the current one to include in the smudging 

and blending process (provided there is something of the lower 

layer showing through).

Get on your experimenter’s hat and start tinkering. Pick an 

image, pick a tool, and pick a blending option. Spend a few min-

utes exploring the effects; what you do and don’t like; and then 

keep notes about things that might be interesting. When you 

discover something, please share it on the KelbyOne Facebook 

page (fb.com/KelbyOneOnline)! ■ ©
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Photoshop is great for answering what-if questions, such as, “What would it look like if we replaced a floor with 
another material?” In this article, we’ll build a hardwood floor pattern and use a 3D postcard to replace the floor 
in a photo. [KelbyOne members may download the files used in this tutorial at http://kelbyone.com/magazine/issue/

may_june_2015. All files are for personal use only.]

Beyond Photoshop
 replacing the floor in a photo SCOTT ONSTOTT

Step One: Open the Oak.jpg material photo. We’ll first offset this 

texture to see if it has any seams. Choose Filter>Other>Offset. 

Drag the Horizontal slider to +350 pixels to move the seam more 

or less into the middle of this image and click OK.

Step Two: Choose the Spot Healing Brush tool (J) to remove 

the vertical seam. Click Content-Aware in the Options Bar, then 

click on the brush preview thumbnail to open the Brush Picker, 

and specify a soft (0% Hardness), 200-pixel brush. Paint over the 

vertical seam to remove it.

Step Three: Choose Edit>Define Pattern. Type “Oak” as the 

pattern name and click OK. Now that this pattern has been 

added to your library, close Oak.jpg without saving it. 

Step Four: Hardwood floors are composed of individual boards 

with wide aspect ratios. Create a new document (File>New) 

measuring 2,000x200 pixels. Click the Create a New Layer icon 

at the bottom of the Layers panel, and choose Edit>Fill. Choose 

Pattern from the Use drop-down menu, click on the Custom Pat-

tern preview thumbnail to open the Pattern Picker, and select 

your Oak pattern. Click OK.

Step Two

Step One

http://kelbyone.com/magazine/
http://kelbyone.com/magazine/
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Step Five: To simulate microbevels between floorboards, 

choose Layer>Layer Style>Bevel & Emboss. Select Chisel Hard for 

Technique, and then set the Size to 3 px and the Angle to 120°. 

To make the bevels appear dark all the way around, change 

Highlight Mode to Multiply, click on its color swatch, change it to 

black, and click OK to close the Color Picker. Set the Opacity for 

both Highlight and Shadow Mode to 75% and click OK. Choose 

Edit>Define Pattern. Type “Floorboard” as the pattern name and 

click OK. Close the file without saving it.

Step Six: Create a new document measuring 2,000x2,000 pix-

els. Choose Edit>Fill and select Floorboard in the Custom Pattern 

Picker. Check on the Script checkbox, choose Brick Fill from the 

Script drop-down menu, and click OK. In the Brick Fill dialog, set 

Pattern Scale to 0.25, Spacing to 0 pixels, Offset Between Rows 

to 50%, Color Randomness to 0, Brightness Randomness to 0.2, 

and Pattern Rotate Angle to 0 degrees. Click OK.

Step Seven: Choose Edit>Define Pattern. Type “Hardwood 

Floor” as the pattern name and click OK. Close the file without 

saving. (Optional: Choose Edit>Presets>Preset Manager, select 

Patterns as the Preset Type, and delete the Oak and Floorboard 

patterns since we don’t need them anymore.)

Step Eight: Open RomanRestaurant.jpg (that is yours truly in 

the lower-left corner). Choose Layer>New>Layer, type “Floor” 

as the name, and click OK. Press D to set the Foreground color 

to black, and then fill the layer with the Foreground color by 

pressing Option-Delete (PC: Alt-Backspace).

Step Nine: Choose Layer>Layer Style>Pattern Overlay. Select 

Hardwood Floor from the Pattern Picker, and then set Scale to 

50% and the Blend Mode to Luminosity. Click the words “Color 

Overlay” on the left side of the Layer Style dialog. Change the 

Blend Mode to Overlay, click on the color swatch, and choose a 

brown color such as #a06d3b. We now have independent con-

trol over color and texture. Click OK.

Step Nine

Step Six

Step Five
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Step Ten: Choose 3D>New Mesh From Layer>Postcard. When 

prompted, switch to the 3D workspace. Our hardwood texture 

is now a texture map on this flat surface. Select the Floor Mesh 

node in the 3D panel, and switch to the Move tool (V). Click the 

Rotate the 3D Object icon in the 3D Mode section of the Options 

Bar. Hover your cursor outside the image bounds until you see 

a black dot intersected by a curved arrow. Click-and-drag up to 

rotate the plane back so it’s more or less parallel with the floor 

surface implied in the photo.

Step Eleven: With the Floor Mesh node still active in the 3D 

panel, select the Coordinates icon at the top of the Properties 

panel. Increase the X and Y scales in the third column to their 

maximum values of 10,000.

Step Twelve: Using a combination of the Drag, Slide, and Rotate 

the 3D Object modes in the 3D Mode section of the Options 

Bar, move the floor so that it completely covers the floor in the 

photo. It takes some practice to learn how to position objects in 

3D space, but keep at it and try to match the figure.

Step Thirteen: In the Layers panel, click the Eye icon next to 

the 3D Floor layer to toggle it off. Use the Quick Selection tool 

(Q) to select the marble floor, including the areas between the 

chairs. You don’t have to do a perfect job; close is good enough. 

If you select too much, hold the Option (PC: Alt) key and click-

and-drag to remove that area from the selection. Toggle on the 

3D layer, click on it to make it active, and choose Layer>Layer 

Mask>Reveal Selection.

Step Fourteen: Change the blend mode of the 3D layer to Hard 

Light near the top left of the Layers panel. Unlink the 3D layer 

thumbnail from its mask in the Layers panel so you can move 

the 3D layer if want to fine-tune its position without moving 

the mask. We could clone-stamp out the inlaid patterns in the 

marble but I like them. 

By mapping the custom texture we designed onto a 3D postcard, 

we positioned it in space so that it more or less matched the 

perspective of a surface in the photo. Combining that operation 

with a layer mask allows us to easily replace textures and explore 

what-if scenarios. ■ Step Fourteen

Step Ten

Step Eleven

Step Twelve

ALL IMAGES BY SCOTT ONSTOTT
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D E PA R T M E N T  › ›

Photoshop Tips
  boost your productivity and creativity

Welcome to more exciting and useful Photoshop tips. This time 

around, I’m going to share some tips that will free you to experi-

ment creatively without the worry of messing things up. Pho-

toshop is a powerful tool but you don’t have to be intimidated 

when you try new things.

Quick Zero on Blur Gallery
There have been many advances to Photoshop lately that make 

things quicker and easier. One shining example is the Blur Gallery 

(Filter>Blur Gallery), a collection of nondestructive blurs. When 

working with the blurs, especially the Field Blur, there may be 

times when you want to set the Blur of one of the pins to zero. 

Rather than having to move a slider, or drag on the interface, you 

can set a pin to zero by simply holding down Command (PC: Ctrl) 

and clicking on the pin.

Nondestructive Lens Flare
Lens flares add a lot of drama and visual interest to an image 

when used correctly. (Just look at the work of movie director 

J.J. Abrams if you want to see examples of lens flare.) If they’re 

applied directly to the image layer (Filter>Render>Lens Flare), 

you can see exactly where you’re placing the flare; however, you 

can’t manipulate the flare after it’s applied to the image layer, 

and you can’t apply a lens flare to an empty layer.

The trick is to create a new layer filled with 50% gray with the 

blend mode set to Overlay (which hides the 50% gray) before 

applying the flare. To quickly do that, Option-click (PC: Alt-click) 

the Create a New Layer icon at the bottom of the Layers panel to 

bring up the New Layer dialog. Set the Mode drop-down menu 

to Overlay, check on the Fill with Overlay-neutral Color (50% 

Gray) option, and click OK. Now when you apply your lens flare 

to this layer, it can be repositioned and adjusted. 

Easy Placement of 
Lens Flare
This is part two of the 

previous tip on lens flares. 

The problem with the 

50% gray tip is that you 

can’t see the image when 

you’re looking at the filter 

preview in the Lens Flare 

dialog; all you see is a 

gray box. Many times this 

doesn’t matter, but some-

COLIN SMITH



 ›
 ›

 k
e

l
b

y
o

n
e

.c
o

m

059
ALL IMAGES BY COLIN SMITH

› › P H O T O S H O P  T I P S

times when you reposition a lens flare on a gray layer, you’ll see 

the hard edge of the layer.

Here’s a sneaky tip: First, apply the Lens Flare filter exactly 

where you want it directly on the image layer. Now press Com-

mand-Z (PC: Ctrl-Z) to undo the flare. The image no longer has a 

lens flare, but the lens flare settings are saved in memory. Create 

your gray, Overlay layer, and then press Command-F (PC: Ctrl-F) 

to apply the last filter. Now the lens flare will be applied to the 

gray layer exactly where you want it with the settings that you 

chose earlier. 

Dodge and Burn Nondestructively
Dodging and burning is a way to adjust the toning by darkening 

and lightening different portions of an image to create drama, 

reveal detail, or highlight the important parts of the image. Here’s 

a great way to create nondestructive dodging and burning.

Click the Create a New Layer icon at the bottom of the Lay-

ers panel while holding down the Option (PC: Alt) key. This will 

create a new layer with the New Layer options dialog. In the 

dialog, change the Mode drop-down menu to Overlay. When 

you do this, additional options will appear below Mode. One of 

these options is a checkbox to fill with 50% gray: Click this box 

and click OK. (If you’ve already read the Lens Flare tips, this will 

sound very familiar.) You’ll now have a new layer that’s invisible 

on the image.

You can now use the Dodge and Burn tools (O) directly on 

this new layer and nondestructively modify the image. Another 

advantage of this method is that you can change the Opacity 

of the layer to make the effect subtler, and you can blur it to 

smooth out your brushstrokes. 

Layers to Files
It’s a huge timesaver to do repetitive tasks on separate layers 

within the same document; this keeps the dimensions the same 

for each and also allows you to share assets. This is good for 

catalog and Web items such as book and DVD covers, Web 

banners, and more. When you’re finished, however, there’s an 

easier way to produce the final assets than File>Save for Web, 

hide a layer, File>Save for Web, hide a layer, etc. Just choose 

File>Scripts>Export Layers to Files, and now you can export 

everything in a few clicks. 

Find the Average Overall Color
Have you ever wanted to find the average color of an image? 

Perhaps you need this to create an ambient lighting effect or 

even match the colors with other documents. It’s really easy to 

do. On your layered document, create a composite layer (stamp 

visible) of all your visible layers by clicking on the top layer in the 

Layers panel and pressing Command-Option-Shift-E (PC: Ctrl-

Alt-Shift-E). A new merged layer will be created on top of the 

layer stack. Choose Filter>Blur>Average. Now you can sample 

this color with the Eyedropper tool (I) and take note of the RGB 

colors in the Info panel (Window>Info). This is the average color 

of all the colors on your page. 

Painting on Filters
I’ve mentioned in previous issues how you can paint with an 

adjustment layer in Photoshop, but did you know it’s also pos-

sible to paint a filter on an image exactly where you want it? You 

can even vary the opacity so that you can apply more or less of 

the effect wherever you like. One filter that works particularly 

well is Unsharp Mask. With this method, you can paint on your 

sharpening exactly where and how you like it.

Convert your layer to a smart object by Right-clicking on it 

in the Layers panel and choosing Convert to Smart Object. Go 

to Filter>Sharpen>Unsharp Mask, apply the settings you want, 

and click OK. You’ll notice Unsharp Mask has been applied as a 

smart filter with a layer mask in the Layers panel. You’ll want to 

invert the mask by clicking on it to make it active and pressing 

Command-I (PC: Ctrl-I). The mask will now be filled with black, 

hiding the effect. Choose the Brush tool (B), press X until the 

Foreground color is white, and now have fun painting in the fil-

ter exactly where you want it. To change the opacity and blend 

mode of the smart filter, double-click on the icon that appears to 

the far right of the filter’s name (Unsharp Mask in this example) 

in the Layers panel. This will open the Blending Options dialog.

Resetting Your Tools
When you work a lot in Photoshop, you can end up with some 

weird and whacky settings on your tools. That’s just the way we 

work in Photoshop. But, it’s easy to forget that you made a weird 

change to a tool, and suddenly things aren’t working the way 

you expect. Your first instinct is to blame Photoshop; it’s surely a 

bug! Very often, though, it’s just a tool setting that you forgot to 

put back the way it was. To easily reset your tools in Photoshop, 

Right-click on the icon of your active tool at the far left of the 

Options Bar right above the Toolbox, and choose Reset Tool, or 

Reset All Tools if you want to reset every tool in Photoshop. Just 

for clarification, the tools are all the ones you see in the Toolbox 

on the left. ■
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hether you’re setting up a home office, 
upgrading your current workspace, or building  

a new design studio, it’s important to ensure that 
the products that support your work are able to 
handle the archvillains of today’s digital age. If you’re 
a photographer, designer, student, or just a creative 
person, great hardware is an integral part of being 
able to achieve some level of success. After all,  
a wise man once said that with great power comes 
great responsibility. 

The mission here is to make sure your computing 
devices can take full advantage of your creative super­
powers. No one should struggle with just a “stark 
tower,” as it were, in today’s world. Once you have 
the power, what you do with it is entirely up to you.

Remember this: Personal preferences and experi­
ence will always help you achieve your best results. 
This is an introduction to creating a better, faster, 
and more reliable workflow situation based on the 
needs of many in the creative world. The hope is to 
provide you with some useful ideas for your situation, 
help eliminate some common frustrations, and prevent 
you from smashing the gear you may already have. 

A great way to start addressing your workspace is by taking 

inventory—not just of your equipment, but also of your skills, 

resources, and time. All of these things have value, so it will 

be helpful to understand all of your assets. This may also help 

you determine a proper balance between equipment, time, and 

consumable items (such as batteries, paper, gas, etc.) so you 

don’t underprice your services.

While many might say that your computer system and 

peripherals are an issue of your current budget and financing, 

when you look at your potential for new business and expan-

sion, it’s about defining what services you really want to offer. 

Once you know that, you can determine how much you want to 

budget to address those needs. In addition, as “necessity is the 

mother of invention,” requests and experience will dictate what 

you need to offer as your business grows.

You should also evaluate your current practices. What can 

you offer beyond what you currently provide? What is taking up 

too much of your time? What are your most and least cost-ef-

fective offerings? Given the time and expense to you, is your 

price appropriate? Can you specialize in one or more services, 

such as macro photography, retouching, or advertising layout?

Now that you have a better idea of your available resources, 

skills, and potential earnings, it’s time to evaluate your budget. 

No matter what it might be, it’s important to define it. Honest-

ly understanding your financial situation may not be the most 

comfortable of tasks, but it also may help you define your needs 

for the future. Investing in yourself, partnering with another 

person or firm, or even looking at a bank loan of some kind, is 

often far better than maxing out credit cards when you consider 

the interest rates. 

  

All Superhero Images by Malchev/©Dollar Photo Club
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Being mobile and creating mobile content are 

powerful things for today’s photography and 

design professionals. Unfortunately, the secu-

rity of your data can be in jeopardy without 

some additional protection. This is especially 

true for those who may take credit cards at 

trade shows, craft fairs, or art expos. One sim-

ple tool that you can add to your mobile devic-

es is a Virtual Private Network (VPN), whereby 

you connect to another device via the Internet 

privately and with added security. This can be 

point-to-point to a virtual server that encrypts 

and secures your data when you’re online; 

but it can be limited, depending on your ser-

vice provider.

This technology was originally in use by cor-

porations and their employees, but in today’s 

mobile world, more consumers are discovering 

the need for added security. While no solution 

is 100% guaranteed to be secure from hack-

ers, adding a VPN can be extremely helpful in 

exchanging data, uploading/downloading files, 

bypassing geo-data blocked sites, and offering 

secure transactions. 

VPN providers offer pricing that ranges 

from free apps to monthly or annual service 

fees for software that you can install on your 

desktop, tablet, or mobile phone. One com-

pany, Circonus (www.circonus.com) provides 

data monitoring and analytics that are actually 

free for home use, and service plans based on 

volume. Some operating systems even include 

a native VPN client or open-source software 

like Viscosity from Spark Labs (www.sparklabs 

.com). Other titles include Intermapper by 

HelpSystems (www.helpsystems.com) for 

more advanced network management. 

Some service providers, such as CyberGhost 

(www.cyberghostvpn.com), offer their own 

software for most platforms with unlimited 

bandwidth. A more recent free VPN for Mac 

and Windows is Tunnelbear (www.tunnelbear 

.com), which requires you to create a user 

account once you install their desktop client.  

Their free service has a 500-MB monthly 

bandwidth limit, which may only be enough 

for some photos and not video. This company 

does offer more bandwidth and will give you 

an extra gigabyte if you promote them on social 

media from within the software, plus $4.99/

month and $49.99/year packages. 

For mobile devices, if you find that your 

super senses are tingling and it seems too good 

to be true, read the user reviews for the current 

version. Since VPN is supposed to secure your 

data and help prevent hacking, you can imag-

ine what a villain’s app might do to your phone. 

CyberGhost apps are popular with options 

ranging from free basic service up to around 

$10.99/month, depending on your needs. With 

unlimited bandwidth, this is a good option for 

creative professionals.

  

http://www.circonus.com
http://www.sparklabs.com
http://www.helpsystems.com
http://www.cyberghostvpn.com/en_us
https://www.tunnelbear.com
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There are all kinds of digital design and photography superheroes. Whatever 

your super-skills may be, think about how to market yourself, and highlight 

those services. In addition, if you have a special experience, background, or 

work in a specific realm (such as concert photography, animation, etc.), it’s 

important to let people know these things. After all, whether you were bitten 

by a radioactive insect, fell into a vat of plasma, or wear a supersuit, the origins 

of your abilities make for great selling points in business. If you’re starting out, 

introductory promotions combining services or offering special pricing may 

help you go from sidekick to superhero in no time at all.

It can be helpful to create a wishlist for all levels of your business so that 

you can identify areas that may need support. Know your nemeses! These 

can include:

	 Time management

	 Current system limitations and slowness

	 Distractions on-site and online

	 Having proper backup systems
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As a rule of thumb, it’s a good idea to have at least three times 

the amount of storage space that you need before you include 

project and client files. 

For most graphics, video, and photo professionals, filling the 

maximum capacity for your system with the fastest possible 

RAM is always better. Companies like OWC (www.macsales 

.com), Crucial (www.crucial.com), and Kingston (www.

kingston.com) offer lifetime warranties.

Tip: It used to be that, when ordering multiple sticks of RAM, 

it was recommended that you get each stick from a different 

reliable vendor, as there was less risk of getting a bad pair of 

sticks from a single supplier. In today’s world, however, there 

may be pricing incentives to matched sets to fill your available 

slots or even replace the original RAM in your computer. Com-

pare performance specifications to be sure that you get the 

most from your memory.

It’s so important to protect and maintain your precious 

files, so back up, back up, and back up some more. Unlike 

years ago, it’s simple and can be automated easily with soft-

ware such as: Carbon Copy Cloner for Mac from Bombich 

Software (www.bombich.com); SuperDuper for Mac from 

Shirt Pocket (www.shirt-pocket.com); AOMEI Backupper for 

Windows (www.aomeitech.com); or Reflect from Macrium 

for Windows (www.macrium.com). 

It can be very exciting to shop for new hardware; how-

ever, design and photo pros should go for a system that 

exceeds the minimum requirements and capabilities of 

the current software and applications that you use. This 

adds longevity and speed to any system. 

Newer desktop and laptop systems depend more on 

external storage vs. internal capacity, but they should 

have faster processors and solid-state drives (SSDs). 

Consider screen resolution and size with external display 

options. And, always go with an extended warranty—

third-party or manufacturer’s—depending on the cover-

age you need.

https://www.macsales.com
http://www.crucial.com
http://www.kingston.com/us
http://www.kingston.com/us
http://bombich.com
http://www.shirt-pocket.com
http://www.aomeitech.com
http://www.macrium.com
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Unbelievably, in this age of hybrid laptop/tablet devices,  

it may not be as easy as it appears in the manufacturer’s 

marketing materials for a road warrior in the design and 

photo business. In fact, carrying cases are available for  

some models of iMacs and all-

in-one PCs to virtually carry the 

desk with you. Again, define 

your needs and look at the 

balance between on-site and 

online. This is especially true if 

you choose to do any real edit-

ing, as you may want to recali-

brate your display for lighting in 

the field.

Laptops tend to be a great 

balance of power, speed, portability, and pricing, but it’s 

always a good idea to have a proper padded case to pro-

tect them. Configured properly and with the maximum 

amount of RAM, there isn’t much that can’t be accom-

plished by today’s newer models.

Mobile storage can also be quite useful. With VPN, 

new hardware, and a good Internet connection (via 

hotspot, phone, or network connection), you might con-

sider cloud storage. It’s more reliable, affordable, and 

available than ever before with options 

starting at no cost; however, it’s import-

ant to really (and thoroughly) read the 

terms of service agreements for any 

provider, as there are differences.

One favorite cloud provider is the New Zealand-

based MEGA (www.mega.co.nz) with their free plan 

of 50 GB—yes, fifty gigabytes—plus secure link sharing, 

mobile apps, desktop sync apps, and a Web app that 

are easy enough for almost any user. There are others 

of course, such as DropBox (www.dropbox.com) with 

2 GB of space to start (although you can get more free 

space if your friends sign up); Copy (www.copy.com) 

with 15 GB of space; and Box (www.box.com) with  

10 GB of free storage; to name a few. If you want to take 

your storage access to the next level, you can also set up 

your own server. Western Digital, NETGEAR, Seagate, HP 

and others offer both entry-level and professional-grade 

hardware for your home or office. An interesting alter-

native is with a Drobo (www.drobo.com) storage solu-

tion and a Drobo app that allows remote access. 

You have your computer system ready, you’ve 

taken inventory of your assets, you’ve identified 

your needs, and you put 

forth your offerings; but 

wait, you know that there 

are a few more things you 

need to get the job done.

Adding a few pieces of hardware can be the 

formula for profitability and an increased return 

on your investment (ROI). 

Think about a larger or additional external 

monitor. New displays like the 4K, 5K, and 

even curved models from HP, Samsung, View-

Sonic, and NEC range in price from hundreds 

to thousands of dollars, but they can save time 

by giving you visual access to more of your 

software with more precise calibration for accu-

racy. Be sure that you don’t get more monitor  

than your graphics card will support, and look 

at connectivity options, such as Thunderbolt, 

for best results and the potential for further 

expansion down the road. 

 

  
  

  
  

https://mega.nz
https://www.dropbox.com
https://www.copy.com/page/home;section:landing
https://www.box.com
http://www.drobo.com
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Offering consistently accurate color, density, 

and clarity is a must-do part of working with 

any creative platform. Even as there are vari-

ations to every make and model of display—

from theater to mobile device, and everything 

in between—today’s creative heroes know that 

great quality can save the day. “What about 

black and white or special effects,” you may 

ask? Having a properly calibrated display is even 

more paramount so that you don’t need to  

be rescued at some point.

Check out calibration tools from Datacolor 

(spyder.datacolor.com), including the various 

Spyder products, which include hardware 

options for almost any budget. Another great 

option is ColorMunki from X-Rite (www 

.colormunki.com).

When you know that you need to be superfast, there 

are a few ways to get the most out of your digital 

fortress to the point where you may want to put on 

your super suit. Moving from a traditional hard drive 

to a solid-state drive (SSD) is more reliable, affordable, 

and functional than ever before. If you were holding 

out, OWC has an entry-level model that can replace 

your laptop’s internal drive that starts at $50 for 60 GB, 

and enterprise-performance 50-GB drives starting at 

around $350.

For desktop (and even some laptop) users, dual 

graphics cards can be like removing the chokehold from 

your computer. If you run multiple large or high-reso-

lution displays, you can get a huge performance boost 

from upgrading to a second graphics card. Sapphire 

(www.sapphiretech.com), NVIDIA (www.nvidia.com), 

and others have different options, but be sure that you 

match your system, display, and performance needs  

to get the best results. Most manufacturers have a 

guide online, or simply call them at the number listed on  

their website.

 

http://spyder.datacolor.com
http://www.colormunki.com
http://www.colormunki.com
http://www.sapphiretech.com/Default.asp?lang=eng
http://www.nvidia.com/content/global/global.php
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Of course, one of the essential tools of the trade has many 

names: Memory card, memory stick, flash card, and others 

come in a huge range of models and types. P2, microP2, 

CFast, XQD, SD, miniSD, SmartMedia, and all kinds of other 

potentially secret identities can cause confusion. While most 

folks have their own personal preferences, below are a few 

simple suggestions that may help you get what is best for 

your needs:

	� Use professional-grade  
products that are usually faster  
and more reliable (but they do  
have a higher price).

	� Always go with a  
lifetime warranty.

	� Look for compatibility with video— 
especially the newer 4K, 5K, and 
1080p—as needed.

	� Check the read- and write-speed 
specifications. For most applications, 
a read/write speed of greater than 
250MB/s is recommended.

	� Get more than you need—both  
the card space and the quantity  
of cards you carry.

	� Use a proper storage case to  
help prevent damage, exposure to 
moisture, crushing, direct sunlight, 
static, or anything that might poten-
tially harm your precious cards.

	� Don’t rely on factory-provided 
cables with your camera.

Get a good-quality card reader with the appropriate host 

connector for your desktop or mobile system. Many are now 

available with a superfast Thunderbolt connection, and sever-

al models cost less than $30. Read user reviews from factory 

authorized resellers to screen for any potential conflicts or errors 

with a particular brand. Check out professional-grade readers, 

such as the following, which accept multiple types of cards:

	� NZXT Aperture M  
(www.nzxt.com)

	� Ultra U12-40529 Aluminus or  
Leather X (www.ultraproducts.com)

	� IOGEAR GFR281  
(www.iogear.com)

	� Atech Flash Technology XM-37U  
(www.atechflash.com) 

Consider investing in a large-capacity, memory-card backup 

storage device to protect your files and data in the field, such 

as the HyperDrive Colorspace UDMA 2 (www.hypershop 

.com). Models range from 120 GB to 1 TB, with some offering 

Wi-Fi connectivity, and some with rechargeable models. 

https://www.nzxt.com
http://www.ultraproducts.com/
https://www.iogear.com
http://www.atechflash.com
https://www.hypershop.com
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Now that we’ve seen the superhero potential for your office, 

home, or mobile workspace, one question remains: What do 

you do with the outdated gear that you already own? In some 

cases, you can repurpose, reuse, or reinvent some of that gear.

You could turn old computers into file or media servers. 

You could also remove their internal hard drive(s) and install 

them into USB 3, FireWire, SATA, or Thunderbolt external 

drive enclosures. 

You could securely erase the hard drive, install your oper-

ating system of choice, and sell it, or donate it for a tax write-

off. Other ideas include using it for a security system with 

streaming audio/video to your mobile device, or use it as a 

lobby or office display to loop examples of your work.

Still and video cameras can be refreshed and updated. 

Clean the sensor and save it as a backup camera. Replace 

the memory card and battery, and check to be sure that 

you have the latest firmware installed—even if the model is 

discontinued, because many manufacturers offer either the 

latest firmware version in their archives, legacy updates, or 

even third-party updates (use with caution). Finally, you could 

get creative and, like any “vintage” photographer, use it to 

create an effect based on its capabilities.

Spending lots of money is not always the answer when the 

question is about creating the best possible computer setup 

for today, tomorrow, and beyond. It’s one of realizing the 

current needs, the plans for the future, and then figuring out 

how to keep it as affordable as possible. That may mean start-

ing with a system that can expand, or starting with a simpler 

system that you’ll replace, as needed, in due time. ■



http://kelbyone.com/magazine/
http://kelbyone.com
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DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

“You’re sitting at your desk, you’re 
stressed out, but as soon as 

you see the site, it immediately 
drops you into your body.”

Candace Combs launched In-Symmetry in San Francisco in 1999, 

providing outcall massage services to touring Broadway produc-

tions and bands. The business soon moved to Los Angeles, where 

it continued to serve clients in the entertainment industry. But in 

2001, she moved back to San Francisco and opened the In-Symme-

try Wellness Spa, offering hot stone massages as well as an exten-

sive menu of skin-care treatments.

Combs has marketed In-Symmetry on the Web from the begin-

ning, with a website for the outcall massage services. Since then, 

she’s revamped her site every three or four years to keep it fresh 

and to reflect additional services—the current site is about two or 

three years old. Most of her site visitors come from her social media 

efforts. Combs maintains a strong presence on Yelp, Facebook, and 

Twitter, and also uses Google AdWords. “You have to promote your 

site from all sides,” she says, “and get people from everywhere.”

For the past seven years, the site has been designed by the same 

person, a friend of Combs who does Web design mostly for large 

companies. “In-Symmetry is one of the few small businesses she 

provides design services to,” says Combs, who goes on to say that 

she is “super happy” with the current site. She likes the colors, she 

loves the prominent image of the Buddha, and she thinks the design 

is clean and flows well. The symbols at the top of the page are the 

Chinese ideograms for fire and water: “They’ve been part of the 

studio’s website since day one,” Combs says. “But I don’t know if 

people really look at websites any more,” she continues. “I haven’t 

seen a site I like in a long time. They all sort of look like this.”

Nevertheless, Combs agreed to let us invite three designers to 

give her spa’s website a rejuvenation treatment. What she’d want a 

visitor to get from a revised site would be a “peaceful” feeling, she 

says. “You’re sitting at your desk, you’re stressed out, but as soon as 

you see the site, it immediately drops you into your body.”

identity treatment
before

CLIENT
In-Symmetry
www.insymmetry.com

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR 
IF YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNCTIONING WEBSITES, ETC.)

http://www.insymmetry.com
mailto:letters%40photoshopuser.com?subject=
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“…my second idea was to add 
three eye-catching, animated 

slides at the top of the page, 
presenting news and promotions.”

When I first saw the In-Symmetry website, I instantly knew it 

could be improved. I decided to completely redesign the site 

and clean it up, especially the homepage. I closed my browser 

with the original In-Symmetry website and started working on 

a completely new approach with enhanced graphics, text, lay-

outs, and navigation.

The first thing I realized was that the current site isn’t com-

patible for big screens, so I decided to increase the resolution of 

the page up to 1,200 pixels. I had also noticed that the current 

version of the website didn’t have any movement or animations, 

so my second idea was to add three eye-catching, animated 

slides at the top of the page, presenting news and promotions. 

I decided to change the colors of the website by adding black, 

dark gray, light beige, and gold to create a stronger appeal to 

visitors of the site.

When people visit a website, they don’t like to scroll and click 

multiple links to find information. In-Symmetry needed navigation 

improvement to make the site easier to use. I reduced the amount 

of content on the homepage by creating separate animated boxes 

with short descriptions of monthly deals‚ facials‚ massages‚ and 

spa packages. Since the majority of In-Symmetry visitors are com-

ing from social media, I knew that adding social-media interaction 

outlets would be vital for the success of traffic on this site. The 

last thing I knew to add was an interactive Google map under the 

content page so that it would be a smooth transition between the 

site information and getting directions on computers, tablets, and 

smart phones.

This website now has a clean and polished appearance that 

instantly highlights the services of In-Symmetry, and allows for easy 

navigation throughout.

APPLICATIONS USED: Adobe Dreamweaver CC, Adobe Photoshop CC, and Adobe Edge Animate CC

MICHAL PERZ 
Michal Perz is a graphic Web designer and digital marketer from Portland, Oregon. Born and raised in Poland, Michal moved to the United 
States four years ago. He studied for three years at Portland Community College, where he specialized in graphic design.

In 2014, Michal established his company, called PKMdesigns, LLC. Since then, he has created graphics and websites for restaurants, 
retailers, wholesalers, IT service providers, financial companies, and nonprofit organizations. PKMdesigns provides a full range of Web services 
including: website development and design; blog development; website makeovers; content updates and edits; search-engine optimization 
and marketing services; email marketing; and logo design. Its main customers are small and midsized businesses looking to maximize business 
success from online branding, marketing, and advertising.

Michal says, “I have a raw passion for design and for creating a strong Web presence and brand recognition for companies.”

about the designer

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Michal Perz 
www.pkmdesigns.com

after

http://www.pkmdesigns.com
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For this makeover I had to take a website that is pleasing not only 

to the eye but virtually perfect in the eyes of the client, and make 

it even better. My approach to the project was to make the site a 

little less busy without losing any major functionality.

Taking inspiration from the current site, I decided to keep a nice 

amount of white space and focus on a clean, full-screen approach. 

I also decided to employ the Bootstrap development framework 

and my Bootstrap Extender module to make the site mobile-

friendly. I worked from top to bottom, mainly just coding right 

onto my test server without a rough sketch. 

The header is the logo from the original site cropped down, 

with some CSS styled and positioned text set in Trajan Pro Bold. 

The navigation bar is pretty standard Bootstrap with some minor 

CSS tweaks. The full-width image was made in Fireworks, the sis-

ter program of Photoshop, and is composed of the Buddha with 

the flower from the original site doubled on opposing sides of 

the image.

I filled the space in the middle with two green rectangles 

blended using vector masks. For the pricing list on the side, I used 

a rounded-rectangle tool to create three boxes with drop shadows. 

The text is more Trajan Pro Bold, and the services have an inset 

emboss applied to them.

I picked up the Monthly Memberships feature from the sidebar 

of the original site and cropped it down a bit. To balance it, I used 

Fireworks to make a gift certificate feature for the other side, using 

a picture of Buddha with a green fill over it and some Trajan Pro 

Bold with an inset emboss. I used these features to frame the social 

media section so the eye will be drawn to it. Finally, I used CSS to 

style and position the footer content.

KEN DEMOFONTE 
Ken Demofonte is a freelance Web designer serving the Greater Philadelphia area. Over the past 13 years, he’s been building cutting-edge 
websites that are pleasing to the eye, extremely stable, and quick to load.

Ken built his first website in 2002 for a backyard wrestling federation he co-founded with a friend in school that earned them a Best of the 
Web award its first year running. From there, he went on to design sites for several local businesses. 

In 2006, he graduated from Delaware County Technical School, earning certificates in Computer Network Systems and Web Page Design. 
Ken has had a colorful career path, doing everything from freelance work to consulting to serving as a CTO, and everything in between. 
His current project is Bootstrap Extender, a utility extension module for the popular front-end framework Bootstrap. He lives in Glenolden, 
Pennsylvania, with his girlfriend Tina and their children.

APPLICATIONS USED: Adobe Fireworks CS6, Bootstrap, Bootstrap Extender

about the designer

“My approach to the project 
was to make the site a little 

less busy without losing 
any major functionality.”

after

DESIGNER
Ken Demofonte 
www.kendemofonte.com 

D E S I G N  M A K E O V E R  ›  ›

http://www.kendemofonte.com
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SONY LIN
Sony Lin is a freelance graphic and Web designer and photographer in Vancouver, British Columbia, Canada. He graduated from Vancouver’s 
Emily Carr University of Art and Design in 2002 with a degree in Fine Arts, but lately he has been doing more design work than oil painting.

His Web address leads a lot of people to ask if his last name is really Kun. No, it’s Lin: -kun ( ), which is a Japanese honorific used by anyone 
when addressing or referring to male children or male teenagers, or among male friends. “I’d like my clients to feel comfortable working with 
me as their friend,” says Lin, “so I named my website www.sonykun.com, and incorporated the ideogram into my logo.”

Sony is also an ’80s toy collector. His toy photography can be seen at www.gatchafive.com, which also happens to be the first website 
that he built. ■ 

about the designer

Right away, I noticed that the client offers two major services: mas-

sage and skin care. A common approach to Web design is to rank 

things in order of importance, with the ranking reflected in the 

hierarchy and structure of the design. But what if the client actu-

ally has two things to promote? I decided I’d use the new 2015 

Web design trend of a split screen for this project. This split-screen 

approach allows me to give equal prominence to both services and 

lets viewers rapidly select between them.

The balanced (in symmetry) design also goes well with the cli-

ent’s company name, so I’d also apply this design concept to most 

of the site’s other pages, with graphics on one side and detailed 

copy on the other. Finally, this design is mobile responsive, which 

is particularly important now since Google has announced that 

its search rankings will take into account whether a website is 

mobile-friendly.

The font that I chose for the main header and body is ITC Eras 

Light, because the thin letterforms give a clean and calm feel 

through the page. My original concept was for a black-and-white 

color scheme, which would make the site even more modern; but 

in light of the owner’s statement that she likes to have a calm and 

peaceful feel, I decided that black and white would be too harsh, 

so I changed the primary color to green.

I picked up the Buddha head and orchid photos from the cur-

rent site but tinted them with a green layer so everything is more 

unified. In short, all my design decisions here are intended to cre-

ate a site that’s clean, modern, and easy to navigate.

after

“The balanced (in symmetry) 
design goes well with the 
client’s company name….”

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Sony Lin 
www.sonykun.com 

http://www.sonykun.com
http://www.gatchafive.com
http://www.sonykun.com


Different types of photography often have different and unique equipment requirements. From sports to wildlife 
and landscape to wedding and event to travel, location, and environmental portraiture photography, selecting the 
right gear from the very beginning is an important part of your formula for success. So, we went to some of the best 
award-winning photographers in the business to get equipment advice for photographers who are just starting out.

By Matt Hernandez, Moose Peterson, Frank Salas, and Rick Sammon

P H O T O G R A P H Y  S E C R E T S

Stuff the right 
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Sports Photography      By Matt Hernandez 
Whether you’re an aspiring sports photographer with dreams 
of seeing your work published, or a parent wanting some great 
shots of your own star player, knowing where to start, as far as 
purchasing equipment, can be challenging. There are several 
things to take into consideration before you spend your hard-
earned money on expensive gear. 

The reach of your lens: For most sports, I recommend purchasing 
a lens that zooms to at least 200mm. For a quality action shot, 
being able to take a tight shot of the athlete(s) you’re focusing on 
is important, unless you’re taking a wide-angle shot of the whole 
field. If it’s a sport with a large field, such as soccer, it can be hard 
to get tight, zoomed-in shots, so having a lens with a focal length 
that zooms to at least 200mm is key.

Frames per second: Sports action happens quickly even in youth 
sports, so a camera that will fire faster greatly enhances your 
chances of getting the shot. Frames per second (fps) refers to 
how many images your camera will take per second in succession.  
I would recommend a camera with a minimum of 6 fps to maxi-
mize your time shooting.

ISO capabilities for indoor or nighttime sports: Less light means 
slower shutter speeds, which makes it harder to freeze action. 
Most youth sports fields and arenas don’t have great light, so the 
higher the ISO your camera will go the better. I would recommend 
a camera with at least 6,400 ISO to freeze action.

I personally own two camera bodies, a Nikon D3S and D800. (Note: 
These particular models are no longer in production.) The lenses  
I use are a 70–200 f/2.8 and a 14–24mm f/2.8. I’ve found that this 
gear is plenty to get it done when shooting action, but a single 
camera and lens setup, such as a D3S and 70–200mm, would work 
just fine if you can’t afford two bodies and two lenses. The D3S is 
a higher-end camera, but there are plenty of more affordable solu-
tions if you don’t have a big budget. I found a Canon EOS 7D with 
a 28–135mm f/3.5–5.6 IS lens available on B&H for around $850, 
which would be a great place to start. Because the 7D is a crop 
sensor camera (meaning it has a smaller sensor size compared to a 
camera with a full-frame sensor), the lens has a 35mm equivalent 
of a 218mm zoom, which has enough range for action shots.

As you become more experienced or have a bigger budget, you 
can work toward more advanced gear. For example, a 400mm 2.8 
lens is great for football, which has a large field, and a 300mm 
f/2.8 lens will help you get good shots even from across the court 

when shooting basketball. Lenses with a lower minimum aperture 
are more expensive than lenses with variable apertures, but they’re 
well worth the money if you can afford them. 

Camera equipment isn’t cheap, so if you’re just getting started, 
my advice is to start with a less expensive setup, and buy more 
advanced gear as you become more serious in sports photography. 

TOP TEN THINGS IN MATT'S BAG

1.	 Nikon D3S

2.	 AF-S NIKKOR 70–200mm f/2.8 ED VR II

3.	 AF-S NIKKOR 14–24mm f/2.8 ED

4.	 Paul C. Buff Einstein E640 Flash Units

5.	 Westcott 48" Rapid Box Octa XXL

6.	 Westcott 7' Parabolic Umbrella (silver interior)

7.	 Manfrotto 057 Carbon Fiber Tripod

8.	 Hoodman HoodLoupe 3" LCD Loupe

9.	 Large Westcott Scrim Jim

10.	 Westcott Black/White Collapsible Backdrop
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Wildlife & Landscape  
Photography By Moose Peterson

So you wanna get into wildlife or landscape photography and 
you’re looking at all the lens options, but you’re at a loss. You 
might look at price and that alone sends the wheels turning. Per-
sonally, I’ve always gone with the best I could afford because it will 
last while delivering quality.

There are two lenses that I think are really excellent first 
options that will work in concert with both wildlife and land-
scape photography: the AF-S NIKKOR 80–400mm f/4.5–5.6G 
ED VR and the AF-S NIKKOR 18–35mm f/3.5–4.5G ED. These 
are amazingly sharp, incredibly flexible lenses that fit perfectly 
in these categories. The 80–400mm has a 
great range: Its long end of 400mm is great 
for birds; 300mm is great for big game; and 
as you slide down toward 80mm, it can slip 
beautifully into landscape photography. 

The 18–35mm is a wickedly sharp lens in a 
small and lightweight package that’s ideal for 
landscapes. You need a lens that can be used 
in more traditional locations as well as in the 
more awkward locations where the great 
landscape images are often made. You also 
need a compact package for all those times 
that you’ll be handholding in low light levels. 
And think of a focal-length range with the 
ability to focus on close subjects for those big 
dramatic sweeps. (If you’re wondering about 
camera bodies, go with either the Nikon 
D7200 or D750; they’re small and light, yet 
fast with beautiful files.) 

This photo of a boat-billed heron is the per-
fect example of the abilities of the 80–400mm 
lens. Since the lens is light and well balanced, it 
was easy working from a sea kayak in a lagoon 
in Costa Rica to make the shot. The photo was 
taken handheld, which is pretty common in 
wildlife photography. The 400mm reach and 
a balanced lens permits you to concentrate on 
the subject and not the gear. 

Chasing the setting sun on Seal Rock 
Beach in Oregon, this image demonstrates 
how the 18–35mm lens excels with land-
scape photography. With its wide range of 
18mm, getting close and low to the subject, 
shooting at a downward angle, and being 
chased by the waves, it was simple to get 
the big sweeping shot of the color, both real 
and reflected.

These two lenses share the same filter size, which permits you 
to get just one polarizer and one screw-in split neutral-density fil-
ter and use them on both lenses. (I like the Nikon Slim Polarizer 
and Schneider Split-grad.) When you want to shoot that far-off 
landscape with the 400mm and remove the blue-sky reflection, 
you can do that easily with a polarizer. When you’re working up 
close on a bird nest with the 18–35mm, you can control the back-
ground with the split-grad filter. 

TOP TEN THINGS IN MOOSE’S BAG

1.	 Nikon D4S

2.	 Nikon D750

3.	 AF-S NIKKOR 800 f/5.6E FL ED VR

4.	 AF-S NIKKOR 80–400mm f/4.5–5.6G ED VR

5.	 AF-S NIKKOR 24–70mm f/2.8G ED

6.	 AF-S NIKKOR 24mm f/1.4G ED

7.	 Profoto B2

8.	 RØDE Mic1

9.	 Gitzo 5562LS Tripod

10.	 Really Right Stuff BH-55 Full-Sized Ballhead

As your photography progresses, what should you add to your 
arsenal next? Do you find yourself wanting to get closer? A telecon-
verter or longer lens could be in your future. Are you always step-
ping back to get more in the frame? Then an ultra-wide or fisheye 
might be the next lens to join your camera bag. When looking for 
the perfect lens for your photography, understand that there is no 
perfect lens. They’re tools, and for them to be perfect, they must 
work in concert with your photography. Keep in mind you’re a 
storyteller and select the lenses that aid in the story you want to tell.
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Wedding and Event 
Photography By Frank Salas

Starting out as a professional wedding photographer, there are a 
few major must-haves when it comes to shooting with the right 
gear. Over many years of experience, I’ve found the right lenses, 
flashes, memory cards, camera bodies, and more that work for me. 
Here are some things to think about to get you started.

The camera: The basic rule of thumb here is not just what brand 
to buy, but also to carry a second body as a backup. You never 
know when the camera will malfunction during a very important 
moment of your event. Invest in DSLRs that range from 12–23 
megapixels, which is good enough to make enlargements of the 
most popular sizes.

Lens choice: We all dream of owning every lens that a cam-
era manufacturer produces, but the reality is that you can start 
out with a single lens with a focal range that covers most sin-
gle or group photos. The overall go-to lens is either the Canon 
EF 24–70mm f/2.8L or the EF 24–105mm f/4L lens. These lenses 
are wide enough for groups and wedding-party photos. If you’re 
ready to go to the next level and build your basic lens kit, here are 
the three lenses I recommend: the Canon EF 16–35mm f/2.8L, the 
EF 24–70mm f/2.8L, and the EF 70–200mm f/2.8L. These give you 
the best overall range. 

Flash and lighting: It goes without saying that off-camera flash 
is what most wedding and event photographers use for all-pur-
pose lighting. It’s lightweight and can be used as a direct light or 
bounced for a softer look. For a more advanced setup, try going 
off camera with the flash by placing it on a light stand. You’ll need 
some type of receiver and transmitter combo to fire the flash from 
your camera.

TOP TEN THINGS IN FRANK'S BAG

1.	 Canon EOS-1D X
2.	 Canon EOS 5D Mark III
3.	 Canon EF 35mm f/1.4L USM
4.	 Canon EF 50mm f/1.4L USM
5.	 Canon EF 16–35mm f/2.8L II USM
6.	 Canon EF 24–70mm f/2.8L II USM
7.	 Canon EF 100mm f/2.8L Macro IS USM
8.	 Canon EF 70–200mm f/2.8L IS II USM
9.	� Two Canon Speedlite 600EX-RTs w/Speedlite  

Transmitter ST-E3-RT

10.	 Sekonic LITEMASTER PRO L-478DR light meter

Memory cards: This is pretty basic, but not having enough memory 
cards can become a disaster when it’s a paying job and you run out 
of space. Those who shoot in RAW format understand this issue.

Light meter: Even though your camera has a built-in light meter, 
learning how to use a handheld meter is worth it. It will keep you 
more focused on being creative instead of staring at the back of 
your camera all day long. The other bonus is if your images are 
correctly exposed, you’ll spend less time behind the computer.

Tripod: A tripod for most events comes in handy. With today’s 
high ISO capabilities, you can usually get away without using a 
tripod; however, a tripod allows you to shoot at lower ISOs so you 
can capture night shots and eliminate most, if not all, noise.

Batteries: Finally, extra batteries are a must. Whether it’s for your 
camera body or flashes, you don’t want to be without them. 
Rechargeable batteries are a great investment, especially if you’re 
doing multiple events over a weekend.
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 Travel & Environmental  
Portraiture By Rick Sammon

You’ve heard it a million times: “Cameras don’t take pictures, 
people do.” It’s true, but you still need a camera to capture and 
share your creative vision. I’ve been making travel, location, and 
environmental portraits (people pictured in their surrounding 
environment) since 1976, when I made my first international trip 
to China. Thirty-nine years ago, I shot with the bare necessities. 
Today, my camera bag is a bit heavier.

If you plan to travel to the other side of the world (or to the 
other side of the country) to make environmental portraits, here 
are my suggestions on gear to get you started, and on gear to give 
your more creative options.

The bare necessities: If you could take only one lens, I’d recom-
mend a 24–105mm. With that lens you can do environmental por-
traits (at the 24mm setting) and portraits (at the 105mm setting). 
I’d also recommend a full-frame image sensor camera. Mine is the 
Canon EOS 5D Mark III. 

My can’t-leave-home-without-it accessory is a reflector/diffuser 
kit. You don’t need a big kit; just one large enough (30" when 
unfolded) for a head-and-shoulder shot. A reflector/diffuser lets 
you control the light for more pleasing portraits. The diffuser, 
when placed between the sun and subject, eliminates harsh and 
unflattering shadows. The reflector can bounce sunlight onto a 
subject’s face to fill in shadows.

Today, my Canon EF 24–105mm f/4L IS USM lens and Westcott 
Rick Sammon’s On-Location Light Controller and Tote reflector/
diffuser are always with me when I travel.

More versatility, flexibility, and creativity: For more versatility, flex-
ibility, and creativity when it comes to environmental portraits, I’d 
recommend a faster wide-angle lens, such as a 24mm f/2.8. That 
lens will let you shoot in tighter indoor locations. It will also let you 
shoot at faster shutter speeds (to avoid blurry pictures caused by 
camera shake) and lower ISO settings (for less grain) in low light. 

TOP TEN THINGS IN RICK'S BAG

1.	 2 Canon EOS 5D Mark III DSLRs 

2.	 Canon EF 24–105mm f/4L IS USM

3.	 Canon EF 17–40mm f/4L USM

4.	 Canon EF 70–200mm f/4L IS USM lens

5.	 Canon Speedlite 600EX-RT 

6.	 Canon Speedlite Transmitter ST-E3-RT 

7.	 Tiffen 2–8 Stop Variable Neutral Density Filter

8.	 Tiffen Polarizing Filter

9.	 Head-mounted Flashlight

A fast 35mm lens would also be a good choice. Again, I’d recom-
mend a full-frame image sensor camera.

Off-camera flashes: Next on the gear list would be an off-camera 
flash. A flash can be used for daylight-balanced, fill-in flash pic-
tures—pictures that don’t look like flash pictures. Of course, it can 
be used indoors to illuminate a subject or to fill in shadows. When 
used off camera, it can create nice side lighting. For softer, more 
diffused, and wider-angle flash lighting, you can bounce the flash 
into a reflector. (No! Not the flash, the light from the flash.)

A second flash will help you create ratio lighting of a subject; 
it will also help you light a dark background. A lightweight tripod 
would also come in handy for low-light and painting-with-light 
photography. And to paint with light, as I have done on more than 
a few occasions, you need a flashlight.

Gear is great, but here’s the most important thing to remember 
when photographing people: The camera looks both ways. In pic-
turing the subject, you’re also picturing a part of yourself. In other 
words, you’re a mirror. Remember that the mood, feeling, and 
emotion you project will be reflected (mirrored) by your subject—
in their face and in their eyes. Also remember that the eyes are the 
windows to the soul. ■
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 >>LIGHT IT

LOOK, MA, NO STUDIO! THAT’S RIGHT. YOU DON’T NECES-

SARILY NEED A $5,000-A-MONTH PROFESSIONAL PHOTO 

STUDIO TO GET PROFESSIONAL-QUALITY RESULTS. TO  

ILLUSTRATE THAT CONCEPT, I THOUGHT I’D SPEND A 

WEEKEND IN JANUARY TURNING MY DEN (MY MUSIC 

ROOM) INTO A STUDIO.

 TURN YOUR DEN INTO A WEEKEND
DIGITAL PHOTO STUDIO 

By Rick 
Sammon



T he key is to use affordable, easy-to-use, and 

relatively compact lighting gear that can be 

set up quickly and easily. A portable back-

ground stand and both black and white backdrops are 

also important.

This image shows the behind-the-scenes setup for my 

weekend studio. It includes three Westcott Spiderlites 

(constant lights) that I used to light my model. To fill in 

shadows under her chin, I used a Westcott Eyelighter. 

› › L I G H T  I T

Draped on my background stand is a Westcott soft cloth 

white background. 

You’ll notice that I shot tethered to my MacBook Pro.  

I shoot into Lightroom so that my model and I can see the 

pictures on the screen during the shoot. The large image 

makes checking details easy. It also makes the session 

more fun and interactive, because we can both see what 

we’re doing right—and wrong. Tether Tools makes the 

cable and extension I’m using.
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L I G H T  I T  › ›

THE KEY TO LIGHTING
Before going on, here are two very important lighting basics:

1. The larger the light, the softer the light.

2. The closer the light, the softer the light.

So if you want soft light, use large lights and move them closer. 

Here’s my favorite image from the shoot. The soft and even 

lighting was created by the three Spiderlites and the Eyelighter. 

Tip: If you get the Eyelighter, read the directions very carefully. 

The key is to place the Eyelighter 30" from the subject’s face 

at a 45° angle. In addition, the subject should be positioned 

in the middle of the Eyelighter (to get the semicircle of light in 

the bottom of the subject’s irises).

The inset shot of my model is without the Eyelighter. It 

shows soft shadows on the subject’s face, which some of you 

may prefer because the photograph may look more natural. It 

has a different look and feel than my evenly lit portrait. 

Here’s my basic lighting setup (not to scale). I created the 

lighting diagram in www.sylights.com.

http://www.sylights.com
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› › L I G H T  I T

A CHANGE IN MOOD
These two photographs also illustrate how the Eyelighter can 

fill in the shadows. In the non-Eyelighter, unflattering photo

graph, the model leaned a little closer to the camera than 

in the opening image. The point is that moving (the model 

or the light) even a few inches can make a big difference in 

how the light (shadows and highlights) affects your subject. 

Here’s another image from the shoot that illustrates how 

the background, and the model’s outfit, affects the mood of 

the photograph.

CREATING SHADOWS FOR DRAMA
While my model was taking a break, I invited my nephew, Emilio, 

and his girlfriend, Mercedes, over for a fun photo session.

To create a more dramatic image, one with stronger shad-

ows, I used only one Spiderlite positioned on camera left.  

I converted my color file to black and white using Tonality Pro 

from Macphun Software. 

Here’s my favorite image from this shoot. Remember: Shad-

ows are your friend, and shadows are the soul of the photo-

graph. As my fellow KelbyOne instructor Joe McNally says,  

“If you want an interesting portrait, don’t light the entire subject.” 
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L I G H T  I T  › ›

ALL PHOTOS BY RICK SAMMON EXCEPT WHERE NOTED

TURN YOUR OFF-CAMERA FLASH  
INTO A STUDIO STROBE
Got an off-camera flash? Get a Westcott Rapid Box and turn 

your flash into a studio strobe. That’s what I did when turning 

my living room into a studio.

After positioning my model at the piano, I set up my 

Canon 600EX-RT Speedlite in a Rapid Box. I fired it with my 

Canon ST-E3-RT remote (radio) transmitter. My goal was to 

include some of the ambient light in the scene, so I set my 

camera on manual, metered the scene, underexposed by two 

stops, and set my speedlite on E-TTL. After a few test shots,  

I got the shot I needed. 

My model shots in this article were taken with my 

Canon EOS 5D Mark III and a Canon EF 24–105mm f/4 IS 

USM lens.

Have fun, and save some money, by turning your den or living 

room into a pro studio. ■
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PHOTO BY SCOTT KELBY

LIGHTROOM
THE  ADOBE

®

 PHOTOSHOP
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LIGHTROOM WORKSHOP  
Scott Kelby tells us everything we need to know 
about sharpening images in Lightroom CC. p98

MAXIMUM WORKFLOW
Learn how the Snapheal Pro plug-in from Macphun can 
raise your productivity and creativity in Lightroom. p102

PHOTOSHOP 
LIGHTROOM CC 
IS HERE!
ADOBE HAS DONE IT AGAIN WITH THE LATEST  
VERSION OF LIGHTROOM. LEARN ABOUT ALL THE 
NEW FEATURES THAT WILL HAVE A MAJOR IMPACT 
ON YOUR PHOTOGRAPHIC WORKFLOW. p87
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It has been several years since the last iteration of Lightroom, and I know that many of us have been 

anxiously awaiting the release of the newest version of this program. I have to say, I think Adobe has  

really done a great job with Lightroom CC, with many added features that will make your workflow easier 

and more powerful.

New Features in 
Lightroom CC

B Y  R C  C O N C E P C I O N
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There are three major new features in Lightroom CC that will 

take your organization and photography work to another level. 

The inclusion of People view, Panoramas, and HDR tone map-

ping inside Lightroom stand out, and are worth a closer look. 

people view
With so many photographers taking pictures of people, having the 

ability to recognize those people in your catalog and assign them 

names seems like a logical step for Lightroom. People view can be 

found in the Library module under the preview area alongside the 

Grid, Loupe, Compare, and Survey view icons. Once you click on 

it (or press the letter O on your keyboard), a dialog appears ask-

ing whether you want Lightroom to automatically scan all of the 

images in your catalog, or only scan faces as needed.

Having Lightroom automatically scan for faces in your entire 

catalog may sound like a good thing, but if you have thousands 

of images, this could take a while. By selecting the option to 

Only Find Faces As-Needed, you can stop the unnecessary load 

on your computer. Lightroom will only scan the images in the 

currently active source when you enter People view. Your source 

is defined by whatever you clicked on in the left-side panels: your 

catalog, a collection, or a folder. 

Once you’re in People view, the preview area will be split into 

two sections: Named People and Unnamed People. Lightroom 

will then start scanning your source looking for faces in those 

pictures. If it finds faces with similar features, it will group them 

into a stack. After it collects all of this information, you can add 

names to the stacks: Just click on the field below a stack and type 

a name. This will move the stack from the Unnamed section to 

the Named section. 

When you have at least one person in the Named section, 

Lightroom will start making comparisons against the images that 

you have in the Unnamed People section. If it detects similar fea-

tures, it will ask if that picture is the named person. 

You can hold the Option (PC: Alt) key and move your cursor 

back and forth over the stacks to see the series of pictures con-

tained in that stack. If Lightroom has identified all of the faces in 

›  ›  l i g h t r o o m  ›  ›
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You can Right-click a named stack and choose Find Similar 

Faces. (Note: You can also double-click a named stack to enter 

this mode.) Lightroom will find similar faces in your source and 

display them as single, non-stacked images in a section called 

Similar. The named stack on which you Right-clicked will also 

expand into individual pictures in a section at the top called Con-

firmed. You can now drag the correctly identified faces one at a 

time from the Similar section to the Confirmed section, or Shift-

click a series of images to select them and then move them en 

masse. When finished, click on People at the top left to return to 

the Named and Unnamed People view. 

Being able to have Lightroom scan your catalog to “learn” 

the faces of people you’re taking pictures of, and quickly adding 

those images to stacks that you’ve identified, provides an image 

collection that photographers can easily identify. Let’s hear it for 

People view! 

that stack correctly, click on the checkmark to move that stack 

into the Named People group at the top. You can also drag a 

stack from the Unnamed section to the Named section. 

 In images where Lightroom is unable to identify a face, or 

areas where faces aren’t adequately captured, you can double-

click on those pictures to enter single person view. You can then 

drag out the region that defines the face in the picture and iden-

tify the person. When you click in the name field above the face 

and start typing, if that name is already in the Named People sec-

tion, Lightroom will automatically populate the field. Double-click 

the image again to exit single person view. The picture will then 

move to the Named People stack associated with that person. 

›  ›  l i g h t r o o m  ›  ›
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merge to panorama
Having both Photoshop and Lightroom as a suite of applications 

that you can leverage certainly helps your workflow, but nothing 

beats having the features that you need in a single application to 

speed up your photo processing. Previously, Lightroom allowed 

you to organize and catalog images that you wanted to stitch into 

panoramas; however, it required Photoshop to perform the actual 

merge by going to the Photo>Edit In menu and selecting Merge 

to Panorama in Photoshop. Then, Photoshop would run through a 

series of dialogs and processes to merge the panorama that, while 

beneficial, would lock you into waiting for the image to be com-

pleted before you could return to Lightroom for further editing. 

Lightroom CC now offers the panorama feature in its Photo 

menu. Simply select the images that you’d like to merge, and 

either go to Photo>Photo Merge>Panorama, or Right-click on 

one of the selected images and go to Photo Merge>Panorama. 

In a couple of seconds, you’ll be presented with a dialog that 

allows you to customize how this panorama will be merged. 

Before we go any further, it’s important to emphasize the “cou-

ple of seconds” part here. It’s fast, solving yet another problem 

that photographers faced when making panoramic images. 

Panoramic images usually require more than two images. 

A great panorama can be made by shooting with the camera 

in the vertical position and capturing at least five images to 

merge together; but this many images can make the file size 

that you’re working with rather large. Add to this the fact that 

you’re now shooting images at higher and higher resolutions, so 

you’ll find yourself sitting by the computer waiting a while for a 

panorama to finish.

Oftentimes I’ve sat and waited for my panorama to appear 

only to be disappointed with the results. To counter that and 

save time, I’d export really small JPEG versions of the individual 

RAW images to do a test merge. Lightroom CC takes a page out 

of that playbook and creates the preview of the merged images 

using the embedded information in the RAW file. Not only does 

this skip all of the steps I previously did to save time, it performs 

the steps much faster than I ever could—double bonus!

In the Panorama Merge Preview dialog, you can select Spheri-

cal, Cylindrical, or Perspective mode to further refine your pan-

orama, as well as turn on Auto Crop, which will get rid of the 

excess white space after merging the picture. 
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Here’s where Lightroom takes it to the next level: The result-

ing image is a DNG file. That’s right, you now have a RAW HDR 

image, letting you push-and-pull the image with a greater range 

than you could before. 

Adobe has developed this HDR merging in such a way that 

the program actually requires fewer images than you’d normally 

need. When capturing images for an HDR, Adobe recommends 

that you use exposures that are –2, 0, and +2 for the best results. 

When I shoot HDR images, I’m often bracketing five, seven, or 

nine shots to make sure that I get as much range as I need. With 

higher-megapixel DSLRs, this often creates projects that are really 

big, so I’m excited to see how well Lightroom does with less 

information. Actually, I think my external drives are even more 

excited, as they will get filled up at a much slower rate! 

headless mode
Headless Mode is another option for creating panoramas and HDRs 

in Lightroom that’s worth mentioning. To create a panorama, the 

keyboard shortcut is Control-M; HDR is Control-H. If you press Shift-

Control-M or Shift-Control-H, Lightroom will merge your images 

to a panorama or HDR, respectively, without going through the 

preview dialog. It will use the last panorama or HDR settings and 

merge the images in the background, letting you work on other 

images in Lightroom while it takes care of the heavy work for you!

While I believe that these three features are real standouts in 

this new Lightroom CC release, they only scratch the surface of 

what Adobe has brought to the photographic community. For 

some of the smaller features and tweaks in this latest update, 

check out Rob Sylvan’s article on page 92 of this issue. We also 

have a dedicated Lightroom Resource Center at http://kelbyone 

.com/lightroomcc with videos for every single feature that 

Adobe has added. If you’re a KelbyOne member, and you’re new 

to Lightroom, we’ve also added more than 14 new courses on 

Lightroom CC to get you up to speed as fast as possible. For even 

more information on a daily basis, go to LightroomKillerTips 

.com, where Scott Kelby and I share tips, tricks, and even host 

a weekly podcast called The Lightroom Show. You’ll be a Light-

room CC master in no time! ■ 

Once you’re happy with the results, click on the Merge but-

ton and Lightroom CC will merge the RAW images, which will, 

of course, take longer than the preview. Another great addition, 

however, is that the resulting panoramic image in your catalog will 

be a DNG file, which means that the merged photos result in a 

RAW image to which you can make further edits in greater detail. 

working with hdr
HDR was another bone of contention for photographers when 

working in Lightroom, because it required users to work along 

with Photoshop or another program to merge a series of RAW 

images into a single high-dynamic range (HDR) image. Now, 

HDR is available in Lightroom CC as well, and it has some 

great updates. 

First, select the images that you want to merge into an HDR 

and either go to Photo>Photo Merge>HDR, or Right-click on one 

of the images and select Photo Merge>HDR. Lightroom quickly 

presents you with an HDR Merge Preview dialog that’s very simi-

lar to the Panorama Merge Preview dialog. This dialog shows you 

the full 32-bit image, giving you options to correct for alignment 

(when your camera moves during the bracketed exposures) or 

ghosting (when your subject elements move through the brack-

eted exposures). 

When you’re satisfied with the results of the HDR, click on the 

Merge button to process the images in Lightroom—without ever 

leaving the program. 
ALL IMAGES BY RC CONCEPCION

http://kelbyone.com/lightroomcc/lightroomcc
http://kelbyone.com/lightroomcc/lightroomcc
http://lightroomkillertips.com
http://lightroomkillertips.com


Under 
the 

Loupe
Whenever there’s a new release of Lightroom, there are always 
a few features that grab the spotlight, but there’s also a host 
of important and cool new tweaks and additions you’ll want to 
learn about.

new tweaks to lightroom cc
B Y  R O B  S Y L V A N
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I’ve combed through Lightroom CC (Lightroom 6) looking 
for the coolest, lesser-known features that may not get 
top billing, but are still worth knowing about. Here’s what 
I’ve found. (By the way, if you want to check out those 
spotlight-grabbing features, see RC Concepcion’s article on 
page 87.)

add to collections on import
Starting with the Import 
dialog, there’s a new 
checkbox in the File 
Handling panel labeled 
Add to Collection. In 
the past, I’ve taken 
advantage of the fact 
that you can designate 
any regular collection as 
the target collection to 
facilitate adding newly 
imported photos sim-
ply by selecting them 
and pressing the B key. 
This new feature makes 
things even simpler by 
providing the ability to 
add all photos in the 
current import to a col-
lection of your choosing right from the start. 

To use this feature, you just need to check the box to see a 
list of your existing collections, selecting the one to which you 
want to add the current batch of imported photos. Collection 
sets containing at least one regular collection will also display 
in the list. You can either select an existing collection from the 

list, or you can click the plus sign in the panel to open the Cre-
ate Collection dialog where you can give the new collection a 
name, add it to an existing collection set, and even (optionally) 
set it as the target collection, or sync it with Lightroom Mobile. 
Once you configure the rest of your import options, just click 
the Import button to complete the process.

filtering the collections panel
If you’re a heavy collection user like I am, then this one will 
be a real timesaver for you too. This works just like the filter 
in the Keywords List panel. You simply start to type the name 
of the collection you want to find in the Filter Collections field 
and Lightroom automatically filters your collection list down 
to just the names that match. From here, you can select your 
collection to find your photos, and then click the x button in 
the Filter Collections field to reset it back to displaying your 
full list of collections.

monitoring activity
We’ve always been able to see various progress meters for 
different activities (such as current import or exports), but that 
activity monitoring has risen to a whole new level in Light-
room CC. Now we have a full-fledged Activity Center that 
can be accessed by clicking the Identity Plate at the top left 
(see next page).

The Activity Center not only provides a glimpse into the 
background operations currently underway, you can also 
pause-and-play these tasks as needed. For example, if you 
chose to sync your catalog with Lightroom Mobile, you can 
pause the sync operation when you’re on limited bandwidth 
or you just don’t want resources dedicated to that operation at 
the moment. Similarly, you can stop-and-start face-detection 
indexing and address lookup. If another task—such as import, 
export, or preview generation—is underway, you can also can-
cel that operation by clicking its associated cancel button.
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keyword sets and painter tool boosted
The Painter tool sits in the Toolbar under Grid view of the 
Library module, and it may be one of the most underutilized 
tools in Lightroom. Granted, it may not fit into everyone’s 
workflow, but if you’re someone who takes advantage of 
keyword sets, you might want to give it another look. 

We’ve always been able to load keywords into the Painter 
tool for easy application to batches of photos in Grid view, 
but now you can load keywords right from an existing key-
word set. Here’s how:

step one: Click the Painter tool icon to enable the tool.

step two: Press the Shift key to invoke the Keyword Set 
pop-up display.

step three: Select the keyword set that you want to use 
from the Keyword Set drop-down menu. 

step four: Use the Eyedropper tool to select individual 
keywords from the set, or load them all by clicking Select All.

step five: With keywords loaded, paint over thumbnails 
in Grid view as desired to apply the keywords to your photos.

ignore badge clicks
This has long been a minor pet peeve of mine, and I’m so 
glad to see this tiny addition to the Interface tab of the Pref-
erences, found under Lightroom (PC: Edit)>Preferences. 
Thumbnail badges that appear in Grid view and in the Film-
strip are not only visual indications that certain operations, 
such as cropping, keywords, Develop adjustments, and so 
on, have been performed on photos, but they’re also live 
buttons that, when clicked, can take you to the area of Light-
room associated with that operation.

The badges that show in Grid view are easy to avoid due 
to the relatively large size of the thumbnails, but when it 
comes to the small thumbnails in the Filmstrip, I’ve found it all 
too easy to accidentally click a badge/button when attempt-
ing to simply select a photo. In the past, I’ve resorted to turn-



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

095

›  ›  l i g h t r o o m  ›  ›

ing off the display of badges in the Filmstrip, but now I can 
have the badges displayed and check the new Ignore Clicks 
on Badges option in the Filmstrip section to have the best of 
both worlds.

more ways to filter 
The Library Filter bar above the Grid in the Library module is 
one of the most powerful ways to leverage the power of the 
Lightroom catalog. While we’ve been able to filter photos 
by flag status and rating level via the Attribute button of the 
Library Filter, those options have now also been added to the 
Metadata tab.

What’s the difference? Well, when you configure the 
Metadata columns to include a data point such as Rating or 
Flag status, you can get a running tally on the number of 
photos in your current view that meet that criteria, and then 
you can select that data point or even a combination of data 
points to visually filter down to a particular set of photos. 
For example, by including a column for Flag and another for 

Rating, I can see at a glance how many photos in the cur-
rent view meet each level of Flag and Rating status. From 
there, I can make quick selections on any combination of 
those two criteria to find just the photos I want. Of course, 
the real power is that you can combine those criteria with 
any of the other data points contained in the filter. To find 
them, click the Metadata tab of the Library Filter, then click 
the drop-down menu on one of the tabs to see them near 
the top of the list.

finer levels of 
adjustment
The Quick Develop panel in 
the Library module is great 
for times when you want to 
nudge a batch of photos in 
one direction or another via 
the Tone Control adjust-
ment buttons. Each adjust-
ment type has four buttons 
associated with it, and the 
two buttons facing left 
take that adjustment in a 
negative direction, while 
the two right-facing but-
tons take the adjustment in 
a positive direction.

The new tweak to this 
panel in Lightroom CC is 
that by holding the Shift key 
you can now make a finer 

level of adjustment on the two single-arrow buttons associated 
with each adjustment. For example, if you hover your cursor over 
one of the inner Exposure single-arrow buttons, you’ll see that 

it will produce a plus or minus 1/3 
stop exposure adjustment, but 
when you hold down the Shift 
key you’ll see that change to 1/6 
of a stop.

Each of the other adjustments 
get the same finer level of con-
trol with the Shift-key modifica-
tion to about half whatever the 
adjustment amount is without 
the Shift key. Granted, you prob-
ably won’t use that every day, 
but just file it away for that one 
time when it might really come 
in handy.
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backups compressed
This new feature solves two problems at once. Up until now 
you could configure Lightroom to create a backup copy of the 
catalog on exit. What’s new is that now those backup copies 
are automatically compressed into a zip file as part of the pro-
cess. The first problem this solves is related to disk space. While 
catalog files tend not to be too large, they can add up when 
you forget to regularly clean out the old backup copies Light-
room has dutifully been creating over the last six months. Cata-
log files compress really well, and take up much less disk space.

The second benefit that I’m most excited about is that, 
by zipping the catalog files, new users are much less likely 
to open an old backup catalog by accident, poke around, 
and close Lightroom. Then, because of the Load Most Recent 
Catalog default setting in the General Preferences, that old 
backup copy automatically gets opened the next time Light-
room launches, which has the potential to wreak all kinds of 
confusion on the unsuspecting user. Now you have to manu-
ally unzip a catalog file to open it, and hopefully that will only 
happen when it’s needed.

Do yourself (and me) one favor, though; go to the Gen-
eral tab in the Preferences and configure a specific catalog to 
be your default catalog, or set it to Prompt Me When Start-
ing Lightroom, and really protect yourself against having the 
wrong catalog open when you least expect it.

On a related note, you can now set the backup schedule 
right from the Back Up Catalog dialog that appears when you 
exit Lightroom.

gpu utilized
One of the most frequently requested features I’ve heard for 
every version of Lightroom is for it to be faster. Lightroom 
now joins its big brother Photoshop in starting to leverage 
the power of the graphics processing unit (GPU) to improve 
performance. Right now we’re only going to see that related 
performance improvement in the Develop module as we 
make adjustments in real time. Folks who are sitting behind 
high-resolution displays with powerful GPUs will be very 
grateful for this new feature.

Head over to the new Performance tab of the Preferences 
and you’ll see Use Graphics Processor is checked by default if 
your computer’s GPU is supported (if not you’ll see an error). 

easier preference reset
File this one under troubleshooting. If Lightroom ever starts 
acting in an odd and unexplainable manner, you might try 
resetting the preferences. In the past, I’ve seen it cure all man-
ner of odd things, but keep in mind it really does reset your 
preferences, so be prepared to reconfigure them after Light-
room opens. Note: This only works when launching Light-
room. Hold down Option-Shift (PC: Alt-Shift) when launch-
ing Lightroom and you’ll see a prompt asking if you want to 
Reset Preferences or Start Normally. Make your choice and 
Lightroom will open. If you choose to reset your preferences, 
once Lightroom opens, go back through and reconfigure any 
settings you normally change from the defaults. ■

ALL IMAGES BY ROB SYLVAN
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There are two types of sharpening you can do in 

Lightroom: The first is called capture sharpening 

(covered here), which is sharpening that would 

normally happen in your camera if you’re shoot-

ing JPEG. If you shoot RAW, the sharpening in your 

camera is turned off, so we apply it in Lightroom 

instead (by default, all RAW photos have sharp-

ening applied in Lightroom, but if you want more 

sharpening, or if you want to control which type of 

sharpening is applied, and how, then you definitely 

want to read this).

sharpening your photosLightroom 
Workshop 

B Y  S C O T T  K E L B Y

Excerpted from The Adobe Photoshop  
Lightroom CC Book for Digital Photographers
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step one: In early versions of Lightroom, you had to 
view your image at a 1:1 (100%) view to be able to see the  
effects of sharpening, but now, not only can you view it at 
other magnifications, they’ve also improved the sharpening 
technology itself, so you can apply more sharpening with
out damaging your image. To sharpen your image, go to the 
Detail panel in the Develop module. There’s a preview win-
dow in this panel that lets you zoom in tight on one area of 
the image, while you see the normal-size image in the main 
Preview area (if you don’t see the preview window, click on 
the left-facing triangle to the right of Sharpening at the top 
of the panel).

Step Two: To zoom in on an area in the preview win-
dow, just click your cursor on the spot you want to zoom 
in on. Once you’ve zoomed in, you can navigate around by 
clicking-and-dragging inside the preview window. Although 
I use just the default 1:1 zoom, if you want to zoom in even 
tighter, you can Right-click inside the preview window, and 
choose a 2:1 view from the pop-up menu (shown here). Also, 
if you click the little icon in the upper-left corner of the panel 

(shown circled here in red), you can move your cursor over 
your main image in the center Preview area, and that area 
will appear zoomed in the preview window (to keep the pre-
view on that area, just click on the area in the main image). 
To turn this off, click that icon again.

step three: The Amount slider does just what you think 
it would—it controls the amount of sharpening applied to 
your photo. Here I increased the Amount to 90, and while the 
photo in the main Preview area doesn’t look that much dif-
ferent, the Detail panel’s preview looks much sharper (which 
is why it’s so important to use this zoomed in preview). The 
Radius slider determines how many pixels out from the edge 
the sharpening will affect, and personally I leave this set at  
1 (as seen here), but if I really need some mega sharpening 
I’ll bump it up to 2. 

tip: toggling off the sharpening 
If you want to temporarily toggle off the changes you’ve 
made in the Detail panel, just click on the little switch on the 
far left of the Detail panel’s header.

step four: One of the downsides of traditional sharp-
ening in Photoshop is that if you apply a lot of sharpening, 
you’ll start to get little halos around the edge areas within 
your photos (it looks like somebody traced around the edges 
with a small marker), but luckily, here in Lightroom, the Detail 
slider acts as kind of a halo prevention control. At its default 
setting of 25, it’s doing quite a bit of halo prevention, which 
works well for most photos (and is why it’s the default set-
ting), but for images that can take a lot of sharpening (like 
sweeping landscape shots, architectural images, and images 
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with lots of sharply defined edges, like the one you see here), 
you would raise the Detail slider up to around 75, as shown 
here (which kind of takes the protection off quite a bit and 
gives you a more punchy sharpening). If you raise the Detail 
slider to 100, it makes your sharpening appear very much 
like the Unsharp Mask filter in Photoshop (that’s not a bad 
thing, but it has no halo avoidance, so you can’t apply as 
much sharpening).

step five: The last sharpening slider, Masking, is to me 
the most amazing one of all, because what it lets you do is 
control exactly where the sharpening is applied. For example, 
some of the toughest things to sharpen are things that are 
supposed to be soft, like a child’s skin, or a woman’s skin 
in a portrait, because sharpening accentuates texture, which 
is exactly what you don’t want. But, at the same time, you 
need detail areas to be sharp—like their eyes, hair, eyebrows, 
lips, clothes, etc. Well, this Masking slider lets you do just 
that—it kind of masks away the skin areas, so it’s mostly the 
detail areas that get sharpened. To show how this works, 
we’re going to switch to a portrait.

step six: First, press-and-hold the Option (PC: Alt) key 
and then click-and-hold on the Masking slider, and your 
image area will turn solid white. What this solid white 
screen is telling you is that the sharpening is being applied 
evenly to every part of the image, so basically, everything’s 
getting sharpened.

step seven: As you click-and-drag the Masking slider to 
the right, parts of your photo will start to turn black, and those 
black areas are now not getting sharpened, which is our goal. 
At first, you’ll see little speckles of black area, but the farther 
you drag that slider, the more non-edge areas will become 
black—as seen here, where I’ve dragged the Masking slider 
over to 76, which pretty much has the skin areas in all black 
(so they’re not being sharpened), but the detail edge areas, 
like the eyes, lips, hair, nostrils, and outline, are being fully 
sharpened (which are the areas still appearing in white). So, in 
reality, those soft skin areas are being automatically masked 
away for you, which is really pretty darn slick if you ask me.

step eight: When you release the Option (PC: Alt) key, 
you see the effects of the sharpening, and here you can see 
the detail areas are nice and crisp, but it’s as if her skin was 
never sharpened. Now, just a reminder: I only use this Mask-
ing slider when the subject is supposed to be of a softer na-
ture, where we don’t want to exaggerate texture. Okay, on 
the next page, we’re going to switch back to the first photo 
and finish up our sharpening there.

tip: sharpening a smart preview
If you apply sharpening (or noise reduction) to a low-res smart 
preview of an image, the amount you apply might look just 
right. But, when you reconnect your hard drive, and it links to 
the original high-res file, that amount of sharpening (or noise 
reduction) will actually have much less of an effect. So, you 
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might want to leave the sharpening (and noise reduction) for 
when you’re working on the original file.

step nine: Here, I reopened the first photo and, at this 
point, you know what all four sliders do, so now it’s down 
to you coming up with the settings you like. But if you’re 
not comfortable with that quite yet, then take advantage 
of the excellent sharpening presets that are found in the 
Presets panel in the left side Panels area. If you look under 
the Lightroom General presets (the built-in ones), you’ll find 
two sharpening presets: one called Sharpen - Scenic and 
one called Sharpen - Faces. Clicking the Scenic preset sets 
your Amount at 40, Radius at 0.8, Detail at 35, and Mask
ing at 0 (see how it raised the Detail level because the sub-
ject matter can take punchier sharpening?). The Faces one 

is much more subtle—it sets your Amount at 35, Radius at 
1.4, Detail at 15, and Masking at 60.

step ten: Here’s the final before/after image. I started 
by clicking on the Sharpen - Scenic preset, then I increased 
the Amount to 125 (which is more than I usually use, but  
I pumped it up so you could see the results more easily 
here). I set the Radius at 1.0 (which is pretty standard for 
me), the Detail at 75 (because a detailed photo like this can 
really take that punchy sharpening), and I left the Masking 
at 0 (because I want all the areas of the photo sharpened 
evenly—there are no areas that I want to remain soft and 
unsharpened). Now, at this point I’d save this setting as my 
own personal “Sharpening - High” preset, so it’s always just 
one click away. ■

ALL PHOTOS BY SCOTT KELBY



Snapheal and Snapheal Pro from Macphun bring 

object removal, skin healing, and image fixing to 

the masses. The original version, Snapheal, was 

one of the Mac App Store Best of 2012 winners. 

It’s designed to be simple to use and a great value 

for someone looking for an app to edit photos.

macphun snapheal proMaximum 
Workflow B Y  S E A N  M c C O R M A C K
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It works perfectly as a standalone product, but the Pro version 

allows you to use it as a plug-in for Lightroom, Photoshop, Aper-

ture, and Elements. Additionally, the Pro version uses the Clean-

Pics algorithm to remove objects even more accurately, as well 

as having an additional Blur brush for local blurring corrections. 

getting started
Both Snapheal and Snapheal Pro are sold on the Apple Mac Store, 

and like other Macphun products are Mac only. (The name might 

give that away.) For this article, we’re looking at Snapheal Pro, 

as we need a Lightroom plug-in. If you get the trial version from 

http://macphun.com/snapheal, open the disk image file to 

reveal the most basic of installs. Simply drag Snapheal Pro to the 

Applications folder. Double-click on the icon to start. As part of 

the process, you can opt to install the plug-in versions at this point. 

Start Lightroom and find a photo you want to fix. To send it 

to Snapheal Pro, go to Photo>Edit In and choose Snapheal Pro. 

Choose the file type and what version of the file you want to edit. 

Snapheal handles RAW formats via Apple Digital Camera RAW 

conversion when used directly, as well as TIFF, PNG, JPEG, and 

PSD (Pro version only). Snapheal will open, and a processing bezel 

will appear as the file loads. 

looking around
Let’s look at the Snapheal user interface (UI) first before delving 

in. Looking at the top left of the application, we see the Accept 

(checkmark) and Reject (X) icons. These return the file to Light-

room, or abandon the edit, respectively. Next are the Undo and 

Redo icons, grayed out until you’ve started working; then come 

the Zoom tools—100% view, Fit View, Zoom In (+), and Zoom 

Out (–); and the Hand tool to move around the zoomed image. 

The Hand tool isn’t available (or necessary for that matter) in Fit 

View. Zoom responds to Photoshop shortcuts: Command-+ to 

zoom in, Command- – to zoom out, Command-1 for 100%, and 

Command-0 for Fit View.

The two previewing tools are next. Clicking the Eye icon will 

show a before view as long as the button is held. The Compare 

View is next and will place the before and after views side by side. 

Clicking the icon a second time will close the view, as will clicking the 

Close icon at the top right. Compare View is a Fit View and ignores 

the current zoom level. Closing it will go back to the previous zoom. 

Next across the top is the Scissors icon, which opens the Crop 

tool for Snapheal. Finally, on the right are the three main editing 

tools: Erase, the heal part of Snapheal, used to remove unwanted 

objects; Retouch, a local adjustments brush to correct specific 

areas in the image; and Adjust, a set of global tools for changing 

the look of the photo. Adjust is similar to the Basic panel in Light-

room, but with more functions.

Okay, we’ve covered the main UI, so it’s time now to delve deeper 

into the main tools, and then finish with a look at the Crop tool.

erase
Lightroom provides cloning via the Spot Removal tool. While the 

Advanced Healing Brush does give reasonable results, the Draw 

and Lasso tools are clearer to use in Snapheal. Draw is the brush 

equivalent and paints a Rubylith mask over the area you’re select-

ing. Set the size of the brush using the Diameter slider or via the 

Bracket keys ([ and ]) on your keyboard as per Lightroom and Pho-

toshop. You can also click the various-sized circle icons to jump to 

specific sizes, from maximum to minimum.

If you’re not happy with the selections, click the Trash icon 

to delete all the current selections. Command-Z will undo if you 

want to go back a step, and Shift-Command-Z will redo a step. 

The ten most recent steps can be undone or redone.

http://macphun.com/snapheal
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Draw on the regions you want to remove, and then switch to 

the Eraser to clean up the mask. Pressing X will swap between 

Draw and the Eraser. Nothing will change until you press the big 

Erase! button. As Snapheal works its magic, you get treated to 

interesting facts, hints, and quotes.

In the example shown here, the Erase on the top section is 

perfect, but near the arm needs more work. For this, we used the 

Clone tool. There are three options for the Clone tool: Diameter, 

Softness, and Opacity. When fixing things with Clone, it’s often 

better to go for a lower Opacity and build up the effect. Softness 

is good when cloning in a general area, but needs to be harder 

near an edge to keep the edge intact. 

Option-click an area to select it as the clone source. In this 

example, we sampled the dark vertical line below the area that 

needs to be cloned, and then cloned it to make it a continuous 

straight line. For this area, we used an Opacity and Softness of 50. 

Change the Diameter as you work to get into tight corners. Near 

the skin, reduce the Softness to zero.

The skin edge gets a little too hard, so choose a clone source 

with the edge of the skin in the center of the cursor. Then as you 

paint to clone, line up the center of the cursor with the edge of 

the skin that needs repair to get a smooth transition. For this, 

you’ll need to set a higher Softness. (You couldn’t build up a 

cloned area like this in Lightroom—a big plus for Snapheal.) To 

finish, click the Checkmark icon at the top left to save the edits 

and return the photo to Lightroom.

For the Lasso, we’ll use a different image. The Lasso tool can 

be Polygonal, where you click to create corners on a shape, or 

Free, where you draw freehand around an object. When you 

complete the shape in both cases, Snapheal converts it to a Ruby-

lith mask. As with the Draw tool, click Erase to remove the object. 

At first glance, the blend appears good, mostly because the 

log is gone. A closer look reveals hard lines, with little blending. 

Now is a good time to look at the other Erase options. 

For both photos we’ve used the Global Erasing Mode. This is 

designed for big objects like the log, though it’s better with more 
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With each photo, it’s a matter of selecting the Erasing Mode 

that looks best. Sometimes cleanup with the Clone tool is neces-

sary, but the final look is what matters, and Snapheal Erase will 

get you there. 

retouch
This is the local Brush tool, allowing you to 

choose where in the image the adjustment 

is made. The choice of sliders ranges from 

tonal controls to color controls. There’s also 

an option to blur parts of the image.

For this example, we’ll darken the cliff face. To make it easier 

to see where the paint is, click the Eye icon in the Mask section 

to reveal the mask. Anywhere that has that ruby color will be 

affected by the settings. Use the Eraser to remove unwanted parts 

of the mask where it spills onto areas that you don’t want to 

even backgrounds. The other options are Local and Dynamic. 

Local is for sky, clouds, or removing a lot of small objects, while 

Dynamic is for fixing skin blemishes. With our photo, switching to 

Local gives a better blend. 

Speaking of skin, let’s take a look at a portrait. This time, 

we’ll use the Dynamic option and brush over the skin we want 

fixed. To get the best result, we set Precision to Highest. As with 

most things, this will take longer to complete. With all the spots 

selected, we clicked Erase. The results are excellent.



› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 m
a

y
 /

 j
u

n
e

 2
0

15

106

›  ›  l i g h t r o o m  ›  ›

affect. As with Erase, pressing X will swap between paint and 

erase. You can also change the Diameter (the Bracket keys work 

here, too), the Softness, and the Opacity of the brush. Paint until 

the area you want to change has been masked.

Next, turn off the Mask (by clicking the Eye again) to view 

what your settings will do. Here, we turned the Exposure down. 

Unlike Erase, the changes happen in real time as you move the 

sliders. The current settings work for anything you paint, but you 

must click Apply at the bottom of the panel to set them. Once 

Apply is clicked, you can then paint a new 

mask and use completely different settings 

on a different area. 

adjust
This is a global adjustments panel, which means that anything 

changed here applies to the whole image. You can change white 

balance using the Temperature and Tint sliders. Tonality can be 

controlled from the Exposure, Brightness, and Contrast sliders. 

Further micro tonality can be adjusted with the Shadows (acts 

as a fill light), Highlights (recovers highlight detail), and Clarity 

(midtone contrast). Finally, you can add Sharpening and remove 

noise with Denoise. Below is the previous image with adjust-

ments applied.

crop
The final tool to cover is the Crop tool. Entering this mode via the 

Scissors icon applies a rule-of-thirds grid over the photo. Along the 

bottom are the Rotate (left and right) and Flip (horizontal and verti-

cal) icons. Clicking the first Flip button will mirror the image. Next 

is the Crop Ratio, where you can choose from a set of aspect ratios 

and orientations. As you move the crop, the new dimensions of 

the photo appear on the top left of the crop boundary. Finally, you 

can use the Crop Angle slider to correct crooked horizons in your 

photo. To set the crop and return to editing, click Crop on the bot-

tom right. Alternatively, click Cancel to return to the edit window. 

snaphealed
Snapheal Pro isn’t meant to be a Photoshop replacement, but it’s 

a handy and versatile pixel editor that makes a good companion 

to Lightroom for those looking for a nifty photo editor. There’s 

nothing to stop you from using it as a standalone editor for quick 

image fixes, especially as it uses Apple Digital Camera RAW to 

make conversions from RAW files. I’d love if it added a shortcut 

for the Softness control (akin to the Shift-Bracket shortcut we get 

in other apps), but that’s just nitpicking. It’s still an excellent app 

for its target market and price. ■

ALL PHOTOS BY SEAN McCORMACK



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

107

suggested preset workflow 
Once you’ve built up some general adjustment and effects pre-
sets, you can use them in the order that adjustments would typi-
cally be applied to an image. Begin with the general adjustment 
presets that modify the overall color and tonal character of the 
entire image and then move on to those presets that create a 
more specific effect. 

organize presets with logical  
folder groupings
When you save a preset, you can choose where it’s saved and 
even create a new folder for it. For maximum efficiency, create 
and use folder groupings for the presets that reflect what they’re 
used for. This will help you find a specific preset for certain 
adjustments or effects pretty easily. You can create folders by 
selecting New Folder in the Folder drop-down menu in the New 
Develop Preset dialog, or Right-click inside the Presets panel and 
select New Folder.

graduated filter presets for  
darkening skies
In most cases, local adjustments for specific parts of the image, 
such as Graduated Filters (M) and the Adjustment Brush (K), are 
usually not included in presets, simply because they’re targeted to 
the needs of individual images. For some images, however, grad-
uated filters can work well as presets to adjust skies in landscape 
images. Select the Graduated Filter and drag on the area of the 
image you wish to affect. Where you begin dragging, the effect 
will be applied at 100%, and where you end represents the point 
where it has faded to 0%. Everything in between is the gradual 
transition between the two.

Adjust the sliders for the Graduated Filter to apply the 
desired result. When saving the preset, include the Graduated 
Filter adjustments and use a name that describes the area of 
the image that’s affected by the gradient. For example, “Darken 
Top Half of Image,” or “Darken Top Third of Image.” You can 
create these Graduated Filter presets to apply to any area of the 
image that may benefit from an adjustment that’s applied along 
a linear gradient. ■

Lightroom has many areas where you can save presets to record 
settings and speed up your work. In this column, I’ll focus on 
using presets in the Develop module with a look at the basic 
how-to of making Develop presets. I’ll also suggest some preset 
philosophy in terms of different types of presets, when to apply 
them, and how to organize them. 

After you’ve adjusted the image the way you want, click the plus 
symbol next to the Presets header in the left-hand panel of the 
Develop module. A dialog will appear letting you choose which 
Develop settings are included in the saved preset. 

what to include for general presets 
At this point, it helps to clarify in your mind what kind of preset 
you’re saving. Is it one that applies a basic overall adjustment to 
the image that would work well on most photos? Adjustments 
such as these would be basic brightness, contrast, saturation, 
color adjustments, and simple conversion to black and white. 
For this type of preset, you should think broadly and not include 
any adjustments that are focused on the problems of a specific 
image. The preset should work well on most types of average 
exposures.

When making general-improvement presets for average 
images, you might want to create these using a file that has 
good overall exposure and no significant issues that may require 
more specialized corrections. 

naming and grouping presets
When saving a preset, give it a descriptive name that makes it 
easy to understand what it does and for which images it will 
be useful. Of course, you could just call it something more cre-
ative and random, such as “Mango Sunrise Surprise,” but after 
a while, it might be hard to remember just exactly how that will 
affect a photo.

what to include for effects presets
I refer to presets that create a more specialized or stylized look as 
effects presets. These are settings that you could use to create a 
faux-HDR look, black-and-white infrared, a black-and-white look 
that works for foliage or Southwest landscapes, heavy vignettes, 
cross-processing, and even a localized preset that darkens the 
top third of the sky in a horizontal landscape photo (more on 
that in a bit).

When saving a preset such as this, only include the adjust-
ment settings that create that specific effect. For example, for a 
preset that applies a cyan-flavored split tone with a dark vignette, 
only the Split Toning and Post-Crop Vignetting settings would 
be saved.

SEÁN DUGGAN

ADOBE PHOTOSHOP   Lightroom Section ›  ›

& TipsTricks
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Product Reviews

Medium-format DSLR camera
Review by Steve Baczewski

In the day of film cameras, many professionals preferred medium-

format cameras to 35mm for their superior image and print qual-

ity, and it’s no different today with digital. The PENTAX 645Z is a 

51-megapixel, medium-format (MF) camera with a 43.8x32.8mm 

CMOS sensor that’s 1.7 times larger than a full-frame digital cam-

era. Manufactured by Sony, the same sensor is used in new Phase 

and Hasselblad cameras; however, at $8,499 the 645Z is signifi-

cantly less expensive and stands up easily to the competition. It’s 

the only MF to include a 3.2" articulated LCD. In addition, it shoots 

continuously at 3 frames per second in RAW and has 1080p video. 

The 645Z combines form and function, which allows the photog-

rapher to respond quickly to changing conditions and deliver stun-

ning image quality and detail.	

Its black-cast magnesium, weather-sealed body with aluminum 

die-cast chassis is bulky and heavy (3.5 lbs.), but not much more than 

a Nikon D810 or Canon EOS 5D Mark III. The size of the 645Z works 

to its advantage, allowing room for numerous buttons, switches, 

and dials within finger-reach, covering such key features as mirror 

lockup, bracketing, DOF, drive modes, metering, WB, ISO, etc. Also, 

an Info button brings up a quick-access menu on the LCD for addi-

tional frequently used features. This design creates a fluid working 

experience, minimizing annoying trips scrolling through menus. 

Ricoh’s target audience is landscape photographers but the 645Z 

works well as a studio camera with two caveats: PENTAX has only 

two difficult-to-obtain leaf shutter lenses, so a 1/125 shutter speed 

with strobes is it for now; and practical tethering isn’t available yet. 

Lightroom only supports tethering for Canon, Nikon, and Leica cam-

eras. PENTAX has two workarounds: The first one uses a FluCard 

(a Wi-Fi memory card) for remote transfer, but it only works with 

JPEGS; and the second is Image Transmitter 2 (a software solution) 

that has full control over the camera, but costs $200.

Quite a few new and legacy lenses are available for the 645Z.  

In the 1970s and 80s, PENTAX manufactured two popular medium-

format film cameras—the PENTAX 645 and the PENTAX 6x7—

and all of the lenses from the 645 film camera fit directly on the  

“Z,” while the 6x7 lenses work via an adapter. Image stabilization  

is lens-based and, at this point, only two are available.

The 645Z has dual SD memory card slots, and it supports JPEG, 

RAW, DNG, and TIFF file formats. It has a shutter-speed range of 

1/4000–30 seconds, plus bulb, an ISO range of 100–204,800, and a 

dynamic range of 13–14 stops. (A 14-stop dynamic range practically 

eliminates the need for shooting HDR.) The 645Z also includes auto-

mated in-camera HDR composite processing of three RAW expo-

sures and up to five stops traditional HDR bracketing. The bright 

optical viewfinder covers 98% of the field, and displays key settings.

The camera’s 27-point autofocus is based on an APC-sized PEN-

TAX camera and is tightly packed in the center of the large view-

finder; however, the autofocus locks quickly in bright and low light. 

The Live View experience of the 645Z is enhanced by an articulated 

LCD screen, image magnification, and a live histogram, which is 

based on RAW not JPEG information. This provides more precise 

exposure information, especially when using the ETTR technique.

The CMOS sensor in the PENTAX 645Z produces near-noiseless 

files up to ISO 12,800, requiring only a slight adjustment of the 

Luminance slider in Lightroom. The camera has a unique TAV mode 

that lets you select the shutter speed and aperture while the cam-

era selects the appropriate ISO. I found this mode works quite well 

for handheld shooting; nonetheless, to eliminate camera movement 

and mirror vibrations, it’s best to use the 645Z on a tripod, prefer-

ably with mirror lockup, a remote shutter release, or a programmed 

timed-shutter delay. 

When using an MF camera, you need to set your mind to a more 

disciplined, methodical approach, so if you’re used to a fast pace, the 

645Z is not for you. Having said that, though, I highly recommend 

experiencing Ricoh’s PENTAX 645Z because of its superb design and 

sensor. It performs beautifully, keeping up with whatever’s in front 

of you, and its 14-bit RAW files make beautiful 24x36" prints with 

rich color and amazing detail. ■

 �Ricoh’s PENTAX 645Z 

Company: Ricoh Imaging Company, Ltd.	 Price: $8,499 (body only)

Web: www.ricoh.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Image detail; design; battery life

	 Not: Autofocus tracking; continuous burst rates

http://www.ricoh.com
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Flexible Mounting System Clamps to Anything
 Review by Erik Vlietinck

Bluetooth Stylus for Creative Cloud Apps
 Review by Erik Vlietinck

 Jot Touch with Pixelpoint

Dinkum Systems’ products include mounts, clamps, and lens 

shades for photo/video producers, and they’re all based on Loc-

Line modular technology, an extremely robust system originally 

applied in the machine-tool industry. I received their new DSLR 

ProPack for testing. It comes in a handy canvas storage bag, and 

includes a large clamp with five joining segments, one convert-

ible 1/4–20" to 3/8–16" mounting arm with a small clamp, and a 

metal DSLR COMPACT lens shade.

I tried the lens shade, which has a hotshoe/screw thread 

combination at the end, with my Sony Alpha A700 and Zeiss 

24–70mm lens. Using a hotshoe converter, the combination 

worked well, as the lens shade was lightweight enough not to 

damage or even move the converter. The lens shade has one 

huge benefit over the butterfly shade (included with the lens): 

You can bend the joints and move the shade, either out of the 

way entirely or to either side.

The other mounts have bigger joints, potentially able to carry 

more weight. I tried mounting two off-camera flashes between 

books on a shelf, and the segments allowed for enough flexibility 

to position the flash heads where I wanted them.

The Adonit Jot Touch with Pixelpoint is a Bluetooth 4 stylus with 

more than 2,000 levels of pressure sensitivity and palm rejec-

tion technology. With two buttons and a rubberized grip, the Jot 

Touch provides a good grip and balance. It also has a magnetic 

USB charging plug. To recharge it, simply place the Jot Touch on 

the USB stick when it’s plugged into your computer’s USB port. 

Bluetooth styli need applications to support their features, 

which means that apps that don’t integrate with the stylus will 

treat it like your finger. The Jot Touch currently integrates with 

about two-dozen creative and note-taking apps, including Adobe 

Illustrator Draw and Illustrator Line. 

For this review, I used an iPad Air 2 and the Procreate painting 

app, as well as Adobe Photoshop Sketch. Palm rejection was a 

bit imprecise with Photoshop Sketch, and Procreate bluntly states 

that it isn’t supported; however, the other features of Jot Touch 

made up for this. There was no lag when drawing or painting. The 

“feel” surprised me, too, because I never imagined drawing and 

painting directly on a glass surface could be so rewarding and so 

much like creating on paper using a pen, brush, or pencil. 

Adonit has done a really good job with the Jot Touch with  

Pixelpoint: The charging method is clever, and the tip won’t wear 

The one thing that didn’t work was getting a stable mount for 

my Sony Alpha with the 24–70mm lens and vertical grip with two 

batteries (a total of 5.57 lbs.) on the large clamp with five seg-

ments. This proved too heavy for the segments to hold the cam-

era in position safely; however, with three segments, the large 

clamp held the camera in an upright position without a problem.

As you can combine the large and small clamps in the DSLR 

ProPack with any number of segments in between, you can also 

use them as fasteners for backdrops and large reflectors. ■

out for another 50 miles or so. The Jot is definitely worth the 

investment if you use any of the supported apps, but I wouldn’t 

recommend it as a general-use touch pen. For touch selecting, its 

fine point feels less comfortable than a stylus with a mushy rubber 

top or a plastic disc. Even your finger feels better, especially with 

the iPad Air 2’s new glass construction that causes problems with 

most styli. ■

 DSLR ProPack

Company: Adonit	 Price: $99.99

Web: www.adonit.net	 Rating: ◆ ◆ ◆ ◆

	 Hot: Weight; charging method; accuracy; speed 

	 Not: Palm rejection

Company: Dinkum Systems	 Price: $99.95 

Web: www.dinkumsystems.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Strength; flexibility; possibilities; price 

	 Not: 

 ›  ›  GET THE SCOOP ON THE LATEST GEAR

http://www.adonit.net
http://www.dinkumsystems.com
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Not Your Father’s Ring Light
 Review by Michael Corsentino

Portable Flash that Packs a Punch!
 Review by Michael Corsentino

When it comes to creating gorgeous light, there’s no one bet-

ter than famed Playboy photographer and international lighting 

master Jarmo Pohjaniemi. When it comes to innovative, best-

in-class, made-in-the-USA light modifiers, Chimera immediately 

comes to mind. Together, these two luminaries have collabo-

rated and come up with a revolutionary new concept in light 

modifiers, the Chimera RingMAXX. 

The larger the source, the softer the light! The Chimera 

RingMAXX delivers a 48" circle of soft, wraparound illumina-

tion. That’s more than five times the coverage of standard-

sized ring lights. 

The Chimera RingMAXX is available in two versions: the 

1910 for still photography (strobe), and the 1920 for video 

(continuous light). Both RingMAXX models work with four 

lights, making it the ultimate beauty light with the ultimate 

level of control. Each of the four lights is housed in an inde-

pendent and controllable chamber, allowing you to make 

individual power adjustments and have precise control over 

shadows on a per-light basis. The four RingMAXX adjustable 

Following up on the success of their popular Ranger Quadra Hybrid 

400Ws pack and head lighting system, Elinchrom has released the 

next generation ELB 400. While form factor remains nearly the 

same, the ELB 400 is a top-to-bottom refresh with powerful new 

features and enough enhancements and improvements to make it 

a worthy contender. 

Starting things off is the 20% faster recycling time of the 

ELB 400 and its impressive 6.9 f-stop range, allowing operation 

between 7–424Ws. This portable flash system has an intuitive new 

OLED display, which provides easy access to all functions, includ-

ing three new game-changing flash modes: Strobo, Sequence, 

and Delayed. Each provides exciting and previously unavailable 

creative options. 

Slim and trim at just 2.8 lbs. (1.27 kg), and only 4.41 lbs. (2 kg) 

when including a Li-ion battery, the ELB 400 sports an enhanced 

rugged design. Heads weigh only 0.8 lbs. (365 g), including reflector 

and diffuser cap, with the 2.5-m head cables adding 0.77 lbs. (350 g).  

Battery life—all-important on location—sees improved capacity 

with 350 full power flashes from one charge, and it has a new Bat-

tery Rescue feature for restoring discharged Lithium-ion batteries. 

With two heads and two ringflashes to chose from, there’s 

no shortage of options. The Quadra Action Head provides fast, 

light mounts accommodate a variety of popular strobes and 

continuous lights.

Built with portability in mind, the RingMAXX frame and its 

unique fabric construction break down easily for transport. Cham-

ber baffles and adjustable mounts are included. An optional yoke 

for single-stand mounting is available, as well as a daisy-chained, 

mini-jack/phono jack cable harness for triggering all four strobes 

via one common radio transceiver. Chimera Lighting offers a five-

year warranty on these RingMAXX products. ■

motion-freezing flash durations, while the Pro Head has a higher 

guide number and compatibility with HyperSync triggers. Both 

heads include a 50-W daylight-balanced (5500 k) modeling lamp 

with a Continuous mode for video applications. The Quadra Ring-

flash ECO is a portable, lightweight solution, and the Quadra Ring-

flash PRO freezes action with flash durations up to 1/4500.

The ELB 400 has the juice you need to overpower the sun, 

shot-after-shot, in a super-portable, feature-stuffed, easy-to-

use package! ■

 Chimera RingMAXX

 Elinchrom ELB 400

Company: Elinchrom SA	 Price: TBA 

Web: www.elinchrom.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: OLED display; portability; new flash modes; faster recycle 

	 Not: Lacking TTL; I’d like an updated Skyport transceiver

Company: Chimera Lighting	 Price: �Model 1910: $1,950;   
Model 1920: $2,450 

Web: www.chimeralighting.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Design; size; quality of light; adjustability

	 Not: Pricey, but there’s nothing else like it 

http://www.elinchromus.com
http://chimeralighting.com
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Before After

Stylus with a Brush Option
Review by Erik Vlietinck

You Had Me at Frequency Separation
Review by Michael Corsentino

 Pogo Connect 2

The Pogo Connect 2 stylus comes very close to an analog drawing 

and painting experience because of its replaceable nibs and brush 

tips, and it’s unique in that you can configure the Pogo Connect 2 

with an app. This stylus is well balanced and has one button, usu-

ally associated with the Undo command. The standard nib is a big 

rubberized knob; however, you can buy optional, smaller rubber 

nibs and brushes, including the famous Sensu
_
 Brush Tip.	

The Pogo Connect 2 supports a dazzling array of apps, includ-

ing Adobe Photoshop, Ideas, Paper, and Procreate. The stylus 

allows for accurate drawing, and replacing its nibs is easy, as they 

attach to the stylus body with a magnet; however, you do need 

considerable force to unseat a nib or brush, which I fear may cause 

them to wear quickly. The Pogo Connect 2 comes with one AAA 

battery that should last for months. 

What sets the Pogo Connect 2 apart is the B3 Brush Tip 

($19.95), which was designed in partnership with Sensu
_
. The two 

other brushes worked fine, but the Sensu
_
 was a revelation. It out-

performs everything else. Combined with the app, it allows for 

fine control of the stylus, giving perfect tactile feedback on the 

amount of paint deposited, as well as stroke thickness.

I stumbled across this set of timesaving tools while researching 

“frequency separation retouching.” What I found was a one-hour 

video tutorial on the subject by the developer at Intelligent Photo 

Tools (IPT), describing how to accomplish this manually or in a more 

automated, streamlined fashion using their ipt NexGen Actions. 

For those unfamiliar with frequency separation, it’s an 

extremely effective method of retouching where detail and tone 

are split into two separate “low” and “high” layers for indepen-

dent retouching. This allows a degree of control and precision 

otherwise unattainable. The bad news is that, left to your own 

devices, employing this method requires a significant number of 

steps and settings. 

Enter ipt NexGen Actions to save the day. With three dif-

ferent frequency separation actions to choose from, each one 

more robust than the next, ipt NexGen Actions has something 

for everyone. The action I use most often, Base Retouch, packs 

around 50 steps into one click of a button. Done right, retouch-

ing is a time-consuming process, so any extra help is always wel-

come. As automated as the ipt NexGen Actions are, they also 

don’t skimp on flexibility and customization: The amount of 

retouching is completely within your control. 

Ten One Design has an optional Smart Clip ($4.95), which is 

a nice rubberized clip that will hold your Pogo stylus so you can 

attach it to a Smart Cover or Smart Case. I tried it briefly and 

found it held the pen fine but made my Smart Case bulge slightly. 

I wouldn’t hesitate to recommend the Pogo Connect 2 to digi-

tal artists using an iPad Air 2; however, I’d recommend buying at 

least the smaller rubber nibs and the B3 Sensu
_
 Brush Tip, as well. ■

There are a ton of other great retouching, sharpening, resizing, 

color effects, vintage effects, edgy effects, artsy effects, and black-

and-white actions to choose from; all-in-all, around 400 different 

effects and workflow options. These are seriously well-designed, 

inexpensive tools that take care of the heavy lifting for you.

The one downside is that the IPT developer has a bone 

to pick with the new subscription-based pricing model from 

Adobe; consequently, the product doesn’t explicitly support 

Photoshop CC. Nonetheless, I’ve used these actions in my own 

Photoshop CC workflow, and they’ve performed flawlessly. ■

 ipt NexGen Actions

Company: Ten One Design	 Price: Starting at $79.95 

Web: www.tenonedesign.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Pogo configuration app; Sensū Brush Tip; replaceable nibs

	 Not: 

Company: Intelligent Photo Tools	 Price: $30

Web: www.intelligentphototools.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Price; retouching actions; useful, well-designed tools

	 Not: Doesn’t explicitly support Photoshop CC 

 ›  ›  GET THE SCOOP ON THE LATEST GEAR

M
ic

ha
el

 C
or

se
nt

in
o

https://tenonedesign.com/home.php
http://www.intelligentphototools.com


B O O K  R E V I E W S  P E T E R  B A U E R  ›  ›B O O K  R E V I E W S  P E T E R  B A U E R  ›  › 

› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 m
a

y
 /

 j
u

n
e

 2
0

15

112

The subtitle for this book is “Composition, Exposure, Light-

ing, Learning, Experimenting, Setting Goals, Motivation and 

More.” That about covers it, eh? And this book does cover it.  

I especially appreciated the author’s list near the end of Chapter  

13 of 25 things to keep in mind when shooting. (Sounds like 

a lot, doesn’t it? Consider it to be comprehensive.) Numbers  

22 and 25 on the list are my favorites: “Make pictures, don’t just 

take pictures” and “Have fun!” The author teaches primarily by 

showing an image and explaining why that particular image illus-

trates the point he’s making. (Make sure that you don’t skip the 

“Foreword” and “About This Book.”) The author shows a wide 

variety of photos, from Alaska to the Antarctic to California to 

Italy to Myanmar. He includes landscapes, portraits, wildlife, and 

more. Each photo includes info on where it was captured and he 

explains his postprocessing.

Since Adobe switched to the subscription/download model 

from scheduled releases of new versions of its software, it’s 

been extremely difficult for print publishing to stay up to date. 

This book is an excellent fit for those new to Photoshop and for 

those jumping from an earlier version to the latest. Granted, it 

doesn’t cover features released by Adobe after the book went 

to press, but it’s a very good introduction to Photoshop in 

general and to those features added between Photoshop CS6 

and Photoshop CC 2014. The table of contents indicates with 

red stars which features are new. For experienced Photoshop 

users this book may be valuable for those more than 50 red 

stars alone, including almost a dozen for Camera Raw. You 

may want to jump around a little in this book—Chapter 1 is 

“Color Management,” but the Photoshop Preferences aren’t 

discussed until Chapter 24 (of 25).

Photoshop CC: Visual QuickStart Guide  
(2014 release)

Rick Sammon’s Creative Visualization  
for Photographers

By Elaine Weinmann and Peter LourekasBy Rick Sammon

  

Publisher: Focal Press (reviewed as eBook	 Pages: Paperback: 308;  
	 from VitalSource Bookshelf )		  eBook: 285

Website: www.focalpress.com

	 Price: $34.95 (paperback or eBook)	 Rating  ◆ ◆ ◆ ◆ ◆

Publisher: Peachpit Press	 Pages: 520 (plus, associ- 
			   ated website)

Website: www.peachpit.com

	 Price: $39.99	 Rating  ◆ ◆ ◆ ◆

https://www.routledge.com/applied-media
http://www.peachpit.com
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To: Denise
From: KelbyOne Help Desk

 I’m a Canon shooter (although I have no objection to 

other brands, each of which has its own particular loyal 

fan base; I have a Nikon 7900 with a waterproof casing 

for underwater work.) My primary camera is the afford-

able Canon EOS 5D Mark III, and my backup is the 

Canon EOS 5D Mark II. If I’m just walking around, you’ll 

usually find the Canon PowerShot G12 in my pocket. 

(I’ve not recently upgraded the cameras, although the 

latest versions are very compelling.)

Of course, the best camera for a particular shot is 

the camera you have on hand—some of those award-

winning photos were actually captured with an iPhone. 

I also enjoy the versatility of the Canon PowerShot SX30 

IS, which uses a smaller sensor: Its compact size offers 

a lens range from 24–840mm (35mm equivalent), 

but it’s JPEG only—no RAW capabilities. (A tripod or 

monopod is best for long-range images. The maximum 

aperture varies through the zoom levels.) This camera 

is very handy for events such as baseball, football, and 

lacrosse, where the action ranges from in your face to 

long distance.

My lens collection is rather extensive, and most of 

the lenses have in-lens image stabilization (indicated by 

IS in the lens name). Many of the longer zoom lenses 

offer a couple of options for distance and stabilizer 

mode; options for auto and manual focus; and the 

option to disable the stabilization, which can be helpful 

when shooting action using a tripod.

For wide-angle shots, I have a 16–35mm zoom lens, 

as well as a 35mm prime lens. Prime lenses are set to 

one focal range but often offer a much wider aperture 

than do similar zoom lenses. That larger aperture allows 

From The Help Desk	
›  ›

The KelbyOne Member  
	 HELP DESKS 

Are you taking advantage of the Help Desks at the KelbyOne member website? This is the place where you can get all of your 

Photoshop and Lightroom questions answered either by other KelbyOne members or by our Help Desk experts. Not only that, you 

can get photo and computer gear help and advice, as well. What are you waiting for? Visit the Community section on the 

KelbyOne member site today! ■

me to shoot at shorter shutter speeds and lower ISO 

settings, and can separate the subject from the back-

ground much better than comparable zoom lenses with 

a higher minimum aperture setting. Tip: Keep in mind 

the triangle of aperture, shutter speed, and ISO that 

determines exposure.

For portraiture and images when I want to separate 

the subject from the background as much as possible,  

I use the Canon 50mm f/1.2 lens set to the widest aper-

ture. A 50mm lens has an added advantage in that it 

most closely represents what people see, although 

some folk’s eyes are better represented by an 85mm 

lens, which I also own, although its maximum aperture 

is f/1.8.

My most often-used zoom lenses are Canon’s 

24–70mm (which comes with many of the Canon DSLR 

packages) and the 70–200mm IS lens with a fixed aper-

ture of f/2.8. I also have a Canon 70–200mm lens with 

a variable aperture, but it rarely leaves the studio, as  

I prefer the fixed f/2.8 aperture.

If I could carry only one lens, it would be the Canon 

28–300mm zoom, which captures from wide-angle to 

long-range shots, but at the cost of aperture range, 

which results in slower shutter speeds or the need for 

higher ISO settings. An interesting lens, especially for 

video, is the Canon 40mm f/2.8 Ultra-Slim.

I use Canon flashes with a Speedlite transmitter 

for off-camera control and I’m a big fan of Rogue 

FlashBenders to control my lighting. I also have the 

L-shaped Angle Finder C for low-angle shots. Most of 

my lenses are protected by the combat-ready Tiffen 

Ultra Clear filters.  

Pete, I’ve seen your award-winning photos at a number of contests and online. May I ask, “What’s 
in your bag?”—Denise

C O L U M N  › ›

 BY PETER BAUER

Answers to Photoshop and gear-related questions
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